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FOREWORD

This is a very nice book written by one of ASP.NET’s very own Most Valuable Professionals, Imar
Spaanjaars. It takes a lot to be a Microsoft MVP — not only do you need expertise in the subject
matter, you also need to be a great teacher and a technology philanthropist. Through his blogs,
articles, and books, Imar has given a considerable amount of his time to benefit the web develop-
ment community.

Imar has been active in the ASP.NET community for a long time and has written several books
on web development, including the previous version of this book, Beginning ASP.NET 3.5. What
makes this book so special is that it does not assume the reader has any prior knowledge of web
development and at the same time it is a great book for anyone hoping to upgrade to ASP.NET 4.
The book uses the free Visual Studio edition, Visual Web Developer Express 2010, starting from
a chapter covering how to get started and then slowly introducing more advanced concepts in a
seamless fashion.

In the process of helping create Visual Studio 2010 for Web Developers, I often interacted with com-
munity leaders to collect feedback on how we could make the product better for every web developer.
Imar has been using ASP.NET 4 and VWD 2010 Express since their first Beta versions, and has
been pouring in feedback on which bugs are important to fix and which features to emphasize. His
passion for the technology is reflected in this book and I am positive that the readers of this book
will feel that same passion.

ASP.NET 4 and Visual Studio 2010 have feature improvements in many areas, including building
standards-compliant web sites, JScript IntelliSense, jQuery integration, Ajax, CSS improvements,
HTML and markup snippets, Web Deployment, and data integration. I believe ASP.NET 4 and
Visual Studio 2010 are great technologies to build fine web sites, and this book will be an excellent
companion to these products, helping users excel in the world of web development.

—VisHAL R. JosHI

Senior Program Manager Lead
Microsoft Web Platform & Tools
http://vishaljoshi.blogspot.com






INTRODUCTION

To build effective and attractive database-driven web sites, you need two things: a solid and fast
framework to run your web pages on and a rich and extensive environment to create and program
these web pages. With ASP.NET 4 and Visual Web Developer 2010 you get both. Together they
form the platform to create dynamic and interactive web sites.

ASP.NET 4 builds on top of its popular predecessors ASP.NET 2.0 and ASP.NET 3.5. While main-
taining backward compatibility with sites built using these older versions, ASP.NET 4 and Visual
Web Developer 2010 introduce new, exciting features and bring many smaller, but much needed
changes to the framework and development tools.

With each new release of Visual Studio (which includes Visual Web Developer) since Visual Studio
2003, I am surprised by the sheer amount of new functionality and changes Microsoft has been able
to put in the product. Visual Studio 2010 is no exception. A major new feature in Visual Studio 2010
is the full integration of the ADO.NET Entity Framework 4 that lets you work with databases

with very little code. Another great change in Visual Studio is the use of Windows Presentation
Foundation (WPF) for the User Interface which brings a better user experience and new behavior in
Visual Studio itself.

Although not a new feature by itself, the inclusion of jQuery in Visual Web Developer is an excellent
decision that will help you write fancier web sites in less time. jQuery is a compelling client side,
cross-browser JavaScript framework and is discussed in detail in Chapter 11.

If you’re familiar with earlier versions of ASP.NET, you’ll be happy to find many small gems in the
new version of the framework that will make your life as a developer easier. I’ll mention and discuss
these new features throughout this book where appropriate. For a complete list of all new features
in ASP.NET, check out the following white paper at the official ASP.NET web site:

http://www.asp.net/learn/whitepapers/aspnetd/

Probably the best thing about Visual Web Developer 2010 is its price: it’s still available for free.
Although the commercial versions of Visual Studio 2010 ship with Visual Web Developer, you can
also download and install the free Express edition. This makes Visual Web Developer 2010 and
ASP.NET 4 probably the most attractive and compelling web development technologies available
today.

WHO THIS BOOK IS FOR

This book is for anyone who wants to learn how to build rich and interactive web sites that run on
the Microsoft platform. With the knowledge you gain from this book, you create a great foundation
to build any type of web site, ranging from simple hobby-related web sites to sites you may be creat-
ing for commercial purposes.
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Anyone new to web programming should be able to follow along because no prior background in
web development is assumed, although it helps if you do have a basic understanding of HTML and
the web in general. The book starts at the very beginning of web development by showing you how
to obtain and install Visual Web Developer. The chapters that follow gradually introduce you to
new technologies, building on top of the knowledge gained in the previous chapters.

Do you have a strong preference for Visual Basic over C# or the other way around? Or do you
think both languages are equally cool? Or maybe you haven’t made up your mind yet and want to
learn both languages? Either way, you’ll like this book because all code examples are presented in
both languages!

Even if you have some experience with prior versions of ASP.NET, you may gain a lot from this
book. Although many concepts from previous versions are brought forward into ASP.NET 4, you’ll
discover there’s a lot of new stuff to be found in this book, including an introduction to the ADO.NET
Entity Framework, the inclusion of jQuery, ASP.NET AJAX, the many changes to the ASP.NET 4
Framework, and much more.

WHAT THIS BOOK COVERS

This book teaches you how to create a feature-rich, data-driven, and interactive web site called
Planet Wrox. Although this is quite a mouthful, you’ll find that with Visual Web Developer 2010,
developing such a web site isn’t as hard as it seems. You’ll see the entire process of building a web site,
from installing Visual Web Developer 2010 in Chapter 1 all the way up to putting your web site on a
live server in Chapter 19. The book is divided into 19 chapters, each dealing with a specific subject.

> Chapter 1, “Getting Started with ASP.NET 4.” In this chapter you’ll see how to obtain and
install Visual Web Developer 2010. You’ll get instructions for downloading and installing
the free edition of Visual Web Developer 2010, called the Express edition. You are also intro-
duced to HTML, the language behind every web page. The chapter closes with an overview
of the customization options that Visual Web Developer gives you.

> Chapter 2, “Building an ASP.NET Web Site.” This chapter shows you how to create a new
web site and how to add new elements like pages to it. Besides learning how to create a well-

structured site, you also see how to use the numerous tools in Visual Web Developer to cre-
ate HTML and ASP.NET pages.

> Chapter 3, “Designing Your Web Pages.” Visual Web Developer comes with a host of tools
that enable you to create well-designed and attractive web pages. In this chapter, you see how
to make good use of these tools. Additionally, you learn about CSS, the language that is used
to format web pages.

> Chapter 4, “Working with ASP.NET Server Controls.” ASP.NET Server Controls are one
of the most important concepts in ASP.NET. They enable you to create complex and feature-
rich web sites with very little code. This chapter introduces you to the large number of server
controls that are available, explains what they are used for, and shows you how to use them.

XXVviii



INTRODUCTION

Chapter 5, “Programming Your ASP.NET Web Pages.” Although the built-in CSS tools and
the ASP.NET Server Controls can get you a long way in creating web pages, you are likely to
use a programming language to enhance your pages. This chapter serves as an introduction
to programming with a strong focus on programming web pages. Best of all: all the examples
you see in this chapter (and the rest of the book) are in both Visual Basic and C#, so you can
choose the language you like best.

Chapter 6, “Creating Consistent Looking Web Sites.” Consistency is important to give your
web site an attractive and professional appeal. ASP.NET helps you create consistent-looking
pages through the use of master pages, which enable you to define the global look and feel of
a page. Skins and themes help you to centralize the looks of controls and other visual elements
in your site. You also see how to create a base page that helps to centralize programming code
that you need on all pages in your site.

Chapter 7, “Navigation.” To help your visitors find their way around your site, ASP.NET
comes with a number of navigation controls. These controls are used to build the navigation
structure of your site. They can be connected to your site’s central site map that defines the
pages in your web site. You also learn how to programmatically send users from one page to
another.

Chapter 8, “User Controls.” User controls are reusable page fragments that can be used in
multiple web pages. As such, they are great for repeating content such as menus, banners,
and so on. In this chapter, you learn how to create and use user controls and enhance them
with some programmatic intelligence.

Chapter 9, “Validating User Input.” A large part of interactivity in your site is defined by the
input of your users. This chapter shows you how to accept, validate, and process user input
using ASP.NET Server Controls. Additionally, you see how to send e-mail from your ASP.NET
web site and how to read from text files.

Chapter 10, “ASP.NET AJAX.” Microsoft ASP.NET AJAX enables you to create good-looking,
flicker-free web pages that close the gap between traditional desktop applications and web sites.
In this chapter you learn how to use the built-in Ajax features to enhance the presence of your
web pages, resulting in a smoother interaction with the web site.

Chapter 11, “jQuery.” jQuery is a popular, open source and cross-browser JavaScript library
designed to make it easier to interact with web pages in the client’s browser. In this chapter
you learn the basics of jQuery and see how to add rich visual effects and animations to your
web pages.

Chapter 12, “Introducing Databases.” Understanding how to use a database is critical to
building web sites, as most modern web sites require the use of a database. You’ll learn the
basics of SQL, the query language that enables you to access and alter data in a database. In
addition, you are introduced to the database tools found in Visual Web Developer that help
you create and manage your SQL Server databases.

XXiX
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> Chapter 13, “Displaying and Updating Data.” Building on the knowledge you gained
in Chapter 12, this chapter shows you how to use the ASP.NET data-bound and data source
controls to create a rich interface that enables your users to interact with the data in the
database that these controls target.

> Chapter 14, “LINQ and the ADO.NET Entity Framework.” LINQ is Microsoft’s solution
for accessing objects, databases, XML, and more. The ADO.NET Entity Framework (EF) is
Microsoft’s new technology for database access. This chapter shows you what LINQ is all
about, how to use the visual EF designer built into Visual Studio, and how to write LINQ to
EF queries to get data in and out of your SQL Server database.

> Chapter 15, “Working with Data — Advanced Topics.” While earlier chapters focused mostly
on the technical foundations of working with data, this chapter looks at the same topic from a
front-end perspective. You see how to change the visual appearance of your data through the
use of control styles. You also see how to interact with the data-bound controls and how to
speed up your web site by keeping a local copy of frequently accessed data.

> Chapter 16, “Security in Your ASP.NET 4 Web Site.” Although presented quite late in the
book, security is a first-class, important topic. This chapter shows you how to make use of
the built-in ASP.NET features related to security. You learn about a number of application
services that facilitate security. You also learn how to let users sign up for an account on
your web site, how to distinguish between anonymous and logged-on users, and how to man-
age the users in your system.

> Chapter 17, “Personalizing Web Sites.” Building on the security features introduced in
Chapter 16, this chapter shows you how to create personalized web pages with content tar-
geted at individual users. You see how to configure and use ASP.NET Profile that enables you
to store personalized data for known and anonymous visitors.

> Chapter 18, “Exception Handling, Debugging, and Tracing.” In order to understand, improve,
and fix the code you write for your ASP.NET web pages you need good debugging tools. Visual
Web Developer ships with great debugging support that enables you to diagnose the state of
your application at runtime, helping you find and fix problems before your users do.

> Chapter 19, “Deploying Your Web Site.” By the end of the book, you should have a web site
that is ready to be shown to the world. But how exactly do you do that? What are the things
you need to know and understand to put your web site out in the wild? This chapter gives
the answers and provides you with a good look at configuring different production systems in
order to run your final web site.

HOW THIS BOOK IS STRUCTURED

This book takes the time to explain concepts step by step using working examples and detailed
explanations. Using the famous Wrox Try It Out and How It Works sections, you are guided
through a task step by step, detailing important things as you progress through the task. Each
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Try It Out task is followed by a detailed How It Works section that explains the steps you per-
formed in the exercise.

At the end of each chapter, you find exercises that help you test the knowledge you gained in this
chapter. You’ll find the answers to each question in Appendix A at the end of this book. Don’t worry
if you don’t know all the answers to the questions. Later chapters do not assume you followed and
carried out the tasks from the exercise sections of previous chapters.

Since this is a beginner’s book, I can’t go into great detail on a number of topics. For pretty much
each chapter in this book, you’ll easily find numerous other books that exclusively deal with the
topic discussed. Where appropriate, I have included references to these books so you can easily
decide where to go to next if you want to deepen your knowledge on a specific subject.

WHAT YOU NEED TO USE THIS BOOK

This book assumes you have a system that meets the following requirements:

> Capable of running Visual Web Developer. For the exact system requirements, consult the
readme file that comes with the software.

> Running Windows Vista or Windows 7 (both require at least the Home Premium edition), or

one of the Windows Server 2008 editions.

Although you should be able to follow along with most of the exercises using another version of
Windows such as Windows XP (as long as it’s supported by Visual Web Developer), the exercises in
Chapter 19 on deployment require the use of Microsoft’s web server IIS 7 or later, which only ships
with the Windows versions in the requirements list.

Chapter 1 shows you how to obtain and install Visual Web Developer 2010, which in turn installs
the Microsoft .NET Framework version 4 and SQL Server 2008 Express edition; all you need is a
good operating system and the drive to read this book!

CONVENTIONS

To help you get the most from the text and keep track of what’s happening, a number of conventions
are used throughout the book.

Try It Out Conventions
The Try It Out is an exercise you should work through, following the text in the book.
1. They usually consist of a set of steps.
2.  Each step has a number.
3. Follow the steps through with your copy of the code.
4. Then read the How It Works section to find out what’s going on.
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How It Works

After each Try It Out, the actions you carried out and the code you’ve typed in will be explained in

detail.

NOTE Boxes like this one hold important, not-to-be forgotten information that is
directly relevant to the surrounding text.

‘ COMMON MISTAKES Mistakes that are easily made while following the exer-
cises are presented in a box like this. Be sure to read these carefully when you
get stuck in an exercise.

As for styles in the text:
> New terms and important words are italicized when they are introduced.

> Code within the text is presented like this: Request .QueryString.Get ("1d")

> URLs that do not start with www are prefixed with http:// to make it clear it’s an Internet
address. URLs within the text are presented like this: http://imar.spaanjaars.com.

> You’ll see many URLs that start with tinyurl.com which is a handy, online service to make
URLs shorter (and thus easier to type). Entering a tinyurl.com address in your browser

should take you to its final destination.

> Menu items that require you to click multiple submenus have a special symbol that looks like

this: . For example: File &> New > Folder.

> Code or content irrelevant to the discussion is either left out completely or replaced with

ellipsis points (three dots), like this:

<tr>
<td style="white-space: nowrap; ">
. Menu items go here; not shown
</td>
</tr>

The three dots are used regardless of the programming language used in the example, so
you’ll see it for C#, Visual Basic, HTML, CSS, and JavaScript. When you see it in code
you’re instructed to type into the code editor, you can simply skip the three dots and any-

thing that follows them on the same line.
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> Code shown for the first time, or other relevant code, is in the following format:

Dim roles As New ArrayList()
roles.Add("Administrators")
roles.Add("ContentManagers")

To put emphasis on a block of code surrounded by other code, I used a bolded font like this:

<appSettings>
<add key="FromAddress" value="info@planetwrox.com"/>
</appSettings>

The surrounding code is used to make it easier to see where the bolded code should be
placed.

> Quite often, white space in code is irrelevant, as is mostly the case with ASP.NET markup
and HTML. To fit code within the boundaries of this book, I often wrap code over multiple
lines and indent the part that should have been on the previous line like this:

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN"
"http://www.w3.org/TR/xhtmll/DTD/xhtmll-transitional.dtd">

If you’re typing this code yourself, you can put it all on one line, or use the same line breaks
if you prefer.

> Text that appears on screen often has Each Word Start With A Capital Letter, even though
the original screen text uses a different capitalization. This is done to make the screen text
stand out from the rest of the text.

SOURCE CODE

As you work through the examples in this book, you may choose either to type in all the code
manually or to use the source code files that accompany the book. All of the source code used in this
book is available for download from the book’s own page on the Wrox web site at www.wrox.com/
go/beginningaspnet4. If somehow this link no longer works, go to www.wrox.com and locate the
book either by using the Search box or by using one of the title lists. Click the Download Code link
on the book’s detail page to obtain all the source code for the book.

Because many books have similar titles, you may find it easiest to search by ISBN; for this book the
ISBN is 978-0-470-50221-1.

You can download the full source for this book as a single file for each programming language used
in the book (C# or Visual Basic). You can decompress these files with your favorite decompression
tool. If you extract the source, make sure you maintain the original folder structure that is part of
the code download. The different decompression tools use different names for this feature, but look
for a feature like Use Folder Names or Maintain Directory Structure. Once you have extracted the files
from the code download, you should end up with a folder called source and a folder called Resources.
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Then create a new folder in the root of your C drive, call it BegaSPNET, and move the Source and
Resources folders into this new folder so you end up with folders like C: \BegASPNET\ Source and
C:\BegASPNET\Resources. The Source folder contains the source for each of the 19 chapters of this
book and the final version of the Planet Wrox web site. The Resources folder contains files you need
during some of the exercises in this book. If everything turned out correctly, you should end up with
the structure shown in Figure I-1.
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Later chapters have you create folders called site and Release inside the same C: \BegASPNET
folder giving you a folder structure similar to that in Figure I-2.

The site folder contains the site as you’ll build it throughout this book, while the Release folder
will contain your final version at the end of this book. Whenever you’re stuck with some examples
in this book, you can take a peek in the source folder to see how things should have ended up.

If you want to run the site for a specific chapter to see how it works, be sure to open the chapter’s
folder in Visual Web Developer as a web site. So you should open a folder such as c: \BegaASPNET\
Source\Chapter 12 directly rather than opening its parent folder C: \BegASPNET\ Source.
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If you want to following along in both programming languages, create a second folder called c:\
BegASPNETVB to hold the files for the Visual Basic version. This way, the two sites can coexist with-
out any problems. If you create a folder specifically for the C# language, don’t include the hash
symbol (#) as that’s an invalid character in the path name for a web site.

Sticking to this structure ensures a smooth execution of the Try It Out exercises in this book.
Incorrectly mixing or nesting these folders make it harder to carry out the exercises and may even lead
to unexpected situations and errors. Whenever you run into an issue or error that is not explained in
this book, ensure that your site structure is still closely related to the one presented here.

ERRATA

I have made every effort to ensure that there are no errors in the text or in the code. However, no
one is perfect, and mistakes do occur. If you find an error in this book, such as a spelling mistake
or a faulty piece of code, I’d be very grateful for your feedback. By sending in errata you may save
another reader hours of frustration and at the same time you will be helping me provide even higher
quality information.

To find the errata page for this book, go to www.wrox.com/go/beginningaspnet4 or go to www.wrox
.com and locate the title using the Search box or one of the title lists. Then, on the book details
page, click the Errata link. On this page you can view all errata that has been submitted for this
book and posted by Wrox editors. A complete book list including links to each book’s errata is also
available at www.wrox.com/misc-pages/booklist.shtml.

If you don’t spot “your” error on the book’s Errata page, go to www.wrox.com/contact/techsupport
.shtml and complete the form there to send us the error you have found. I'll check the information
and, if appropriate, post a message to the book’s errata page and fix the problem in subsequent edi-
tions of the book.
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P2P.WROX.COM

For author and peer discussion, join the P2P forums at p2p.wrox.com. The forums are a web-based
system for you to post messages relating to Wrox books and related technologies and interact with
other readers and technology users. The forums offer a subscription feature to e-mail you topics

of interest of your choosing when new posts are made to the forums. I am a frequent visitor of the
Wrox forums, and I’ll do my best to help you with any questions you may have about this book.

At p2p.wrox.com you will find a number of different forums that will help you not only as you read
this book, but also as you develop your own applications. To join the forums, just follow these steps:

1.  Go to p2p.wrox.com and click the Register Now link.
2. Read the terms of use and click Agree.

3.  Complete the required information to join as well as any optional information you wish to
provide and click Submit.

4. You will receive an e-mail with information describing how to verify your account and com-
plete the joining process.

You can read messages in the forums without joining P2P but in order to post your own messages,
you must join (which is free).

After you join, you can post new messages and respond to messages other users post. You’ll find this
book’s own forum under the ASP.NET 4 category that is available from the homepage. You can read
messages at any time on the Web. If you would like to have new messages from a particular forum
e-mailed to you, click the Subscribe to this Forum icon by the forum name in the forum listing.

For more information about how to use the Wrox P2P, be sure to read the P2P FAQs for answers to
questions about how the forum software works as well as many common questions specific to P2P
and Wrox books. To read the FAQs, click the FAQ link on any P2P page.

XXXVi


http://p2p.wrox.com
http://p2p.wrox.com
http://p2p.wrox.com
http://p2p.wrox.com

Getting Started with ASP.NET 4

WHAT YOU WILL LEARN IN THIS CHAPTER:

>

>

How to acquire and install Visual Web Developer 2010 Express and
Visual Studio 2010

How to create your first web site with Visual Web Developer

How an ASP.NET page is processed by the server and sent to the
browser

How you can use and customize the development environment

Ever since the first release of the .NET Framework 1.0 in early 2002, Microsoft has put a lot
of effort and development time into ASP.NET, the part of the .NET Framework that enables
you to build rich web applications. This first release meant a radical change from the older
Microsoft technology to build web sites called Active Server Pages (ASP), now often referred
to as classic ASP. The introduction of ASP.NET 1.0 and the associated Visual Studio .NET
2002 gave developers the following benefits over classic ASP:

>

A clean separation between presentation and code. With classic ASP, your program-
ming logic was often scattered throughout the HTML of the page, making it hard to
make changes to the page later.

A development model that was much closer to the way desktop applications are pro-
grammed. This made it easier for the many Visual Basic desktop programmers to make
the switch to web applications.

A feature-rich development tool (called Visual Studio .NET) that allowed developers to
create and code their web applications visually.

A choice between a number of object-oriented programming languages, of which Visual
Basic .NET and C# (pronounced as C-Sharp) are now the most popular.
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> Access to the entire .NET Framework, which for the first time meant that web developers
had a unified and easy way to access many advanced features to work with databases, files,
e-mail, networking tools, and much more.

Despite the many advantages of ASP.NET over the older model, using ASP.NET also meant an
increase of complexity and the knowledge you needed to build applications with it, making it harder
for many new programmers to get started with ASP.NET.

After the initial release in 2002, Microsoft released another version of the NET Framework (called
.NET 1.1) and the development IDE Visual Studio .NET in 2003. Many people saw this as a service
pack for the initial release, although it also brought a lot of new enhancements in both the frame-
work and the development tools.

In November 2005, Visual Studio 2005 and ASP.NET 2.0 were released. To the pleasant surprise
of many developers around the world, Microsoft had again been able to drastically improve and
expand the product, adding many features and tools that helped reduce the complexity that was
introduced with ASP.NET 1.0. New wizards and smart controls made it possible to reduce the code
required to build an application, decreasing the learning curve for new developers and increasing
their productivity.

Although Visual Studio 2005 and ASP.NET 2.0 were already very feature rich, Microsoft managed
again to add a whole bunch of cool new features in Visual Studio 2008 and ASP.NET 3.5, which were
released in November 2007. Major new functionality included LINQ (discussed in Chapter 14) and
the integration of the AJAX Framework (which you learn more about in Chapter 10). In August 2008
Microsoft released Service Pack 1 for Visual Studio and the .NET Framework, introducing major new
features like the ADO.NET Entity Framework (discussed in Chapter 14) and Dynamic Data.

The current versions, Visual Studio 2010 (often pronounced as “twenty-ten”) and ASP.NET 4, build
on top of the successful Visual Studio 2008 and ASP.NET 3.5 releases, leaving many of the beloved
features in place, while adding new features and tools in other areas.

Over the next 19 chapters, you learn how to build full-featured ASP.NET web sites using Visual
Web Developer 2010, Microsoft’s development tool for ASP.NET web applications, which is part
of the full Visual Studio 2010 suite. This book guides you through the process of creating a fully
functional, database-driven web site, starting with a bare-bones web site in this chapter, all the way
down to the deployment of it to a production environment in Chapter 19.

The sample site that comes with this book and all the examples are built with Visual Web Developer
2010 (VWD), so it’s important that you have it installed on your development machine. The next
section shows you how to acquire and install VWD. Once you have it up and running, you see how
to create your first web site, followed by an extensive tour through the many features of VWD.

MICROSOFT VISUAL WEB DEVELOPER

Although you could theoretically write ASP.NET web applications with Notepad or another text
editor alone, you really want to install a copy of Microsoft Visual Web Developer 2010. VWD is
developed specifically for building ASP.NET web sites, and as such, hosts an enormous amount of
tools that will help you in rapidly creating complex ASP.NET web applications.
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Visual Web Developer comes in two flavors: as a standalone and free version called Microsoft Visual
Web Developer 2010 Express, and as part of the larger development suite called Visual Studio 2010,
which is also available in different editions, each with its own price tag. Although the Express edi-
tion of VWD is free, it contains all the features and tools you need to create complex and feature-rich
web applications. All the examples you find in the book can be built with the free Express edition

so there’s no need to shell out big bucks for the commercial versions of Visual Studio 2010 to follow
along with this book.

Getting VWD is easy. You can download it from the Microsoft site as discussed next.

Getting Visual Web Developer

You can get the free version of VWD from the Microsoft site at www.microsoft.com/express/.

On the Express home page, follow the Downloads link until you reach the page that offers the down-
loads for the Express products, including Visual Web Developer 2010 Express. From this page, you
can download Visual Web Developer 2010 Express as a Web Install, where you download only the
installer, while the remaining files are downloaded during the installation process. Make sure you
choose Visual Web Developer 2010 from the page, and not one of the other free Express products or
one of the older editions of Visual Web Developer. The page also enables you to download all Express
products conveniently as an ISO image that you can burn onto a DVD.

Don’t be fooled by the file size of the Web Install download, which is around 3.5MB. The file you
download is just the installer that downloads the required files over the Internet. The total down-
load depends on your current system and will be somewhere between 180 MB and 270 MB.

If you want to try out the full version of Visual Studio 2010, which also contains Visual Web
Developer, you can sign up for a free trial that you can get from the Microsoft site at http://msdn
.microsoft.com/vstudio. You can choose to download an ISO image that you’ll need to burn on
aDVD.

Finally, you can download VWD as part of the Microsoft Web Platform Installer (WPI) application
available for download at www.microsoft.com/web and at www.asp.net/vwd/. Besides VWD, this
tool also gives you easy access to many other web development related tools and programs. The WPI
is an excellent tool to get a whole bunch of web development-related programs and tools in one fell
swoop. I often use it to get up and running real quick on a clean development machine.

Installing Visual Web Developer Express

Installing Visual Web Developer is a straightforward, although somewhat lengthy, process. Depending
on your installation method, your computer and your Internet connection speed, installing VWD may
take anywhere between twenty minutes and an hour or even more.

Installing Visual Web Developer 2010 Express

This Try It Out exercise guides you through installing VWD Express on your computer. It assumes you’re
using the web download option as explained earlier, although the process for installing the Express edition
from a DVD is almost identical. The steps you need to perform to install the full versions of Visual Studio
2010 are similar as well, although the screens you’ll see will be somewhat different.
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No matter which version of VWD you install, it’s important that you also install SQL Server 2008
Express with Service Pack 1 — a required component if you want to follow along with many of this
book’s examples. When you install the full version of Visual Studio 2010, the option to install SQL
Server is included on the list with features to install that you see during setup. If you install VWD
Express, you get the option to choose SQL Server on the Installation Options dialog box. The Web
Platform Installer has a similar option that enables you to install SQL Server 2008 Express with SP1
or later located under Web Platform = Database.

1.

2.

6.

When you’re installing the web version, run the file you downloaded from the Microsoft web site.
Otherwise, start the setup process from the Visual Web Developer DVD.

Once the installer has started, click Next, read and accept the license terms, and click Next
once more.

On the Installation Options page, make sure you select Microsoft SQL Server 2008 Express. Although
this option adds considerably to the size of the download, you really need it when building data-driven
ASP.NET web applications. If you don’t see the SQL Server option, you already have it installed.

If you’re unsure whether SQL Server 2008 is installed, refer to Appendix B. Click Next again. You
may also see other optional components such as Microsoft Silverlight that you can install as well,
although they are not required for this book.

On the Destination Folder page, you can leave the Install In Folder field set to its default if you
have enough space on your primary disk. Otherwise, click the Browse button and select a different
location.

Click the Install button. If you’re using the web-based installer, the setup application will first down-
load the files over the Internet to your computer. During the installation process, you’ll see a screen
(similar to Figure 1-1) that shows you the progress of the download and installation of VWD.
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The installer may need to reboot your machine during or after the installation. Once the installer
has finished, VWD is ready for use.
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How It Works

The straightforward installation process guided you through the setup of VWD 2010 Express. In the
Installation Options dialog box, you selected Microsoft SQL Server 2008 Express, Microsoft’s free
version of its database engine. SQL Server 2008 is discussed and used a lot in this book, starting with
Chapter 12. Appendix B shows you how to configure security settings for the various versions of SQL
Server 2008 using the free SQL Server Management Studio Express.

Now that VWD is installed, it’s time to fire it up and start working with it. The next section shows
you how to create your very first site in VWD. You see how to create a site, add content to a web
page, and view that page in your browser.

CREATING YOUR FIRST ASP.NET 4 WEB SITE

You probably can’t wait to get started with your first ASP.NET web site, so instead of giving you a
theoretical overview of web sites in VWD, the next Try It Out exercise dives right into the action
and shows you how to build your first web project. Then, in the How It Works explanation and the
section that follows, you get a good look at what goes on behind the scenes when you view an
ASP.NET page in your browser.

Creating Your First ASP.NET Web Site

1. Start VWD 2010 from the Windows Start menu if you haven’t done so already. The first time you
start VWD, there might be a delay before you can use VWD because it’s busy configuring itself.
Subsequent starts of the application will go much faster.

2. If you’re using a commercial version of Visual Studio, you also get a dialog box that lets you
choose between different collections of settings the first time you start Visual Studio. The choice
you make on that dialog box influences the layout of windows, toolboxes, menus, and shortcuts.
Choose the Web Development settings because those settings are designed specifically for ASP.NET
developers. You can always choose a different profile later by resetting your settings, as explained
later in this chapter.

3. Once VWD is fully configured, you see the main screen appear, as shown in Figure 1-2.

You get a full description of all the windows, toolbars, panels, and menus in the next section, so
for now, just focus on creating a new web site. Click the File menu in the upper-left corner and
choose New Web Site. If you’re using a commercial version of Visual Studio, depending on the
settings you chose when starting Visual Studio the first time, you may have to open the submenu
New first. (Make sure you don’t accidentally use the New Project menu, because that is used to
create different types of .NET applications.) The New Web Site dialog box appears as shown in
Figure 1-3.
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In the Installed Templates section on the left you can choose a programming language you will use
for your site. This book shows all examples in both Visual Basic and Visual C# so you can choose
a language to your liking.
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Click OK. VWD creates a new web site for you that includes a number of FIGURE 1-4
files and folders to jump start your web site as shown in Figure 1-4. It also
opens the file Default.aspx so you can see the code for the page.

Remove the code inside the <asp:Content> block (it starts with <h2> and ends with </p>) and

replace it with the following bolded text and code:

<asp:Content ID="BodyContent" runat="server" ContentPlaceHolderID="MainContent">
<h2>Hello World</h2>

<p>Welcome to Beginning ASP.NET 4 on <%= DateTime.Now.ToString() %></p>
</asp:Content>

You’ll see code formatted like this a lot more in this book. When you are instructed to type in
code formatted like this with some code in bold, you only need to type in the highlighted code.
The other code should already be present in the file.

Don’t worry about the code with the angle brackets (<>) and percentage symbol in the welcome
message; you learn how it works later. Although this code may not look familiar to you now, you
can probably guess what it does: it writes out today’s date and time.

Press Ctrl+F5 to open the page in your default web browser. You see a page similar to the one
shown in Figure 1-5.

el SEL Tt Uil px '| ] "j-lr."il!ka. =y

o Fawseter | 8 Home Page K = B = 0 # = mge= fatety= Tosk= =

My ASP.NET APPLICATION

HELLO WORLD
Weltame 1o Beginning SSP.NET 4 on 10/30/2009 61518 P |
m . . 0
Done W Local ianet | Protected Moge. O i =~ R v
FIGURE 1-5

If you get a dialog box asking for your user name and password, close your browser and go back

to VWD. Right-click your site in the Solution Explorer (it’s the first item in Figure 1-4) and choose
Property Pages. In the Start Options section clear the checkbox for the NTLM Authentication item.
Then click OK and press Ctrl+F5 again to view the page in the browser. If you see an information
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bar warning about Intranet settings in Internet Explorer, click the bar and choose Enable Intranet
Settings. If you want to learn more about the implications of these settings first, choose What are
Intranet Settings from the popup menu.

If you don’t see the date and time in the page, or if you get an error, look again at the code in

the welcome message. It starts with an angle bracket (<) followed by a percentage symbol and an
equals sign. It closes with a single percentage sign and another angle bracket (>). Also, make sure
you typed in the code exactly as shown here, including capitalization. This is especially true when
you are using C#, because that language is case sensitive.

9. Notice how a small icon with a screen tip appeared in the tray bar of Windows, visible in
Figure 1-6.

If you don’t see the icon, right-click the arrow near the other icons [T A% TIET Dbt Sorves  Pov 83213
in the Windows tray and choose Customize Notification Icons.

Then set the WebDev.WebServer40.exe option to Show Icon and
Notifications. The icon belongs to the ASP.NET Development Server.
This web server has been started by VWD automatically to serve the request for your page. You
learn more about how the web server processes your page later in this chapter.

That’s it. You just created your very first ASP.NET 4 web site with VWD.

FIGURE 1-6

How It Works

Although the web site you created in this Try It Out is quite simple, the process that eventually results
in the page Default.aspx being displayed in your browser isn’t so simple. All by itself, an ASP.NET
page (also referred to as an ASPX page because of its extension) can’t do much. It needs to be processed
and served by a web server before your browser can display it. That’s why VWD automatically started
up the built-in ASP.NET Development Server to handle the request for the page. Next, it started up
your default web browser and directed it to the address of the web server, nttp://localhost:49212/
WebSitel/Default.aspx in the Try It Out example, although the actual number in the address may
change every time you start the web server because the number is randomly chosen by VWD.

It’s important to realize that the ASPX file you modified in VWD is not the same as the one that even-
tually gets displayed by the browser.

When you create a page in VWD, you add markup to it. The markup in an ASPX page is a combination
of plain text, HTML, code for ASP.NET Server Controls (which you learn more about in this chapter
and in Chapter 4), code written in Visual Basic.NET or C#, and more.

When you request an ASPX page in your browser, the web server processes the page, executes any code it
finds in the file, and effectively transforms the ASP.NET markup into plain HTML that it then sends to
the browser, where it is displayed. In the preceding Try It Out, the resulting HTML causes the browser to
display the current date and time. HTML, or HyperText Markup Language, is the language that browsers
use to display a web page. You learn how HTML looks and how to use it later in this chapter.

To see how the final HTML differs from the original ASPX page, open the source for the page in

your browser. In most browsers, you can bring up the source window by right-clicking the page in the
browser and choosing View Source or View Page Source. This brings up your default text editor, show-
ing the HTML for the page.
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If you already closed your browser after the preceding Try It Out, press Ctrl+F5 in VWD to open the
page and choose View Source again.

Most of the HTML you see in the text editor is similar to the original ASPX page. However, if you look
at the line that displays the welcome message and the current date and time, you’ll notice a big differ-
ence. Instead of the code between the angle brackets and percentage signs, you now see the actual date
and time:
<div class="main">
<h2>Hello World</h2>

<p>Welcome to Beginning ASP.NET 4 on 10/30/2009 6:19:16 PM</p>
</div>

When the web server processed the page, it looked up the current date and time from the server, and
inserted it in the HTML that got sent to the browser. Depending on the language settings of your
Windows installation, you may see the date and time formatted differently to accommodate the Windows
Regional Settings.

In the following section, you see how ASP.NET works in much more detail.

AN INTRODUCTION TO ASP.NET 4

When you type a web address like www.wrox.com in your web browser and press Enter, the browser
sends a request to the web server at that address. This is done through HTTP, the HyperText
Transfer Protocol. HTTP is the protocol by which web browsers and web servers communicate.
When you send the address, you send a request to the server. When the server is active and the
request is valid, the server accepts the request, processes it, and then sends the response back to the
client browser. The relationship between the request and response is shown in Figure 1-7.

Because you are using the built-in Development Web Server, the server and the client are really the
same machine. However, in a real-world scenario, you’ll host your
web site on an external web server where it can be accessed by many
different clients.

For simple, static files, like HTML files or images, the web server Web Server

simply reads the file from its local hard drive and sends it to the

browser. However, for dynamic files, such as ASPX pages, this is Request

obviously not good enough. If the web server were to send the ASPX 4 >

file directly to the browser as a text file, you wouldn’t have seen the
current date and time in the browser, but instead you would have
seen the actual code (<%= DateTime.Now.ToString() %>). So,
instead of sending the file directly, the web server hands over the
request to another piece of software that is able to process the page.
This is done with a concept called Application Mapping or Handler Browser
Mapping, where an extension of a file (.aspx in this example) is FIGURE 1-7

Response
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mapped to an application that is capable of handling it. In the case of an .aspx page, the request is
eventually handled and processed by the ASP.NET runtime, part of the Microsoft NET Framework
designed specifically to handle web requests.

During the processing of the page, three main areas can influence the way the page eventually ends
up in the browser:

> Static text. Any static text, like HTML, CSS, or JavaScript code you place in a page, is sent
to the browser directly. You learn more about HTML, CSS, and JavaScript (a programming
language used at the client) in this and subsequent chapters, including Chapter 3, which gives
you a detailed look at CSS.

> ASP.NET Server Controls. These controls are placed in your ASPX page and when they
are processed, they emit HTML that is inserted in the page. You learn more about Server
Controls after the discussion of HTML in this chapter, and Chapter 4 is devoted entirely to
ASP.NET Server Controls.

> Programming code. You can embed code, like Visual Basic .NET or C#, directly in a page,
as you saw in the previous Try It Out. In addition, you can place code in a separate code file,
called a Code Bebind file. This code can be executed by the runtime automatically, or based
on a user’s action. Either way, execution of the code can greatly influence the way the page
is displayed, by accessing databases, performing calculations, hiding or showing specific con-
trols, and much more. You learn more about this Code Behind file in the next chapter, and
programming your ASP.NET web pages is discussed in great detail in Chapter 5.

Once the page is done processing, and all the HTML for the page has been collected, the HTML is
sent back to the browser. The browser then reads it, parses it and, finally, displays the page for you
to look at.

Because HTML is so critical for displaying web pages, the next section gives you an overview of
HTML.

Understanding HTML

HTML is the de facto language for creating web pages and is understood by every web browser that
exists today. Since the beginning of the ‘90s it has been the driving force of the World Wide Web,
the part of the Internet that deals with web pages. HTML documents are simple text files that con-
tain markup, text, and additional data that influences that text.

HTML Elements and Tags

HTML uses text surrounded by angle brackets to indicate how your content should be rendered (or
displayed) in the browser. The text with angle brackets is referred to as a fag; a pair of tags holding
some text or other content is referred to as an element. Take another look at the HTML you saw in
the previous Try It Out where you opened the source window for the page in the browser:

<h2>Hello World</h2>
<p>Welcome to Beginning ASP.NET 4 on 10/30/2009 6:19:16 PM</p>

The first line of this example contains an <h2> element with an opening tag (<h2>) and a closing
tag (</h2>). This element is used to signify a heading at the second level (if you scroll up a bit in the
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final source in the browser, you also see an <h1> element). Notice how the element is closed with a
similar tag, but with an additional forward slash (/) in it: </h2>. Any text between these opening
and closing tags is considered part of the element, and is thus rendered as a heading. In most brows-
ers, this means the text is rendered in a larger font. Similar to the <h2> tag are tags for creating
headings up to level six, such as <h1>, <h3>, and so on.

Below the heading element, you see a <p> element, which is used to denote a paragraph. All text
within the pair of <p> tags is considered part of the paragraph. By default, a browser renders a para-
graph with some additional margin spacing at the bottom, although you can override that behavior.

Many tags are available in HTML; too many to cover them all here. The following table lists some
of the most important tags and describes how they can be used. For a complete list of all HTML
elements, take a look at the web site of the organization that maintains the HTML standard:
www.w3.0rg/TR/html401/index/elements.html.

TAG DESCRIPTION EXAMPLE
<html> Used to denote the start and <html>
end of the entire page. ...All other content goes here
</html>
<head> Used to denote a special sec- <head>
tion of the page that contains Content goes here
data about the page, includ- </head>
ing its title and references to
external resources.
<title> Used to define the title of the <title>
page. This title will appear in Welcome to Planet Wrox 4
the browser’s title bar. </title>
<body> Used to denote the start and <body>
end of the body of the page. Page body goes here
</body>
<a> Used to link one web page to <a href="http://www.wrox.com">
another. Visit the Wrox site
</a>
<img> Used to embed images in <img src="Logo.gif" />
a page.
<b> Used to format text in a bold, This is <b>bold text</b> while
<i> italic, or underline font. <i>this text is in italic</i>
<u>
<form> Used for input forms that <input type="text" value="Some Text" />
<input> enable users to submit infor-
<textarea> mation to the server.
<select>

continues
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(continued)
TAG

<table>
<tr>

<td>

<ul>
<ol>

<li>

<span>

<div>

HTML Attributes

DESCRIPTION

These tags are used to cre-
ate a layout with a table. The
<table> tag defines the entire
table, and the <tr> and <td>
tags are used to define rows
and cells, respectively.

These three tags are used to
create numbered or bulleted
lists. The <ul> and the <ol>
tags define the looks of the
list (either unordered, with a
simple bullet, or ordered, with
a number), and the <1i> tag
is used to represent items in
the list.

This tag is used to wrap and
influence other parts of the
document. It appears as inline,
so it adds no additional line
break on the screen.

Just like the <span> tag,

the <div>tagis used as a
container for other elements.
However, the <div> acts as a
block element, which causes
an explicit line break after the
<div> element by default.

EXAMPLE

<table>
<tr>
<td>This is a Cell in Column 1</td>
<td>This is a Cell in Column 2</td>
</tr>
</table>

<ul>
<li>First item with a bullet</1li>
<li>Second item with a bullet</1li>
</ul>
<ol>
<li>First item with a number</1li>
<li>Second item with a number</1li>
</ol>

<p>This is some normal text while
<span style="color: red;">this text
appears in red</span></p>

<div>
This is some text on 1 line

</div>

<div>
This text is put directly under the
previous text on a new line.

</div>

In addition to the HTML elements, the examples in the preceding table also showed you HTML
attributes. Attributes contain additional information that changes the way a specific element behaves.
For example, with the <img> tag that is used to display an image, the src attribute defines the source
of that image. Similarly, the <span> tag contains a style attribute that changes the color of the text
to red. The value of the style attribute (color: red;)is part of a Cascading Style Sheet (CSS),
which is discussed in much more detail in Chapter 3. Just as with the HTML elements, there is a long
list of available attributes on the W3C web site: www.w3 .org/TR/html401/index/attributes.html.

You don’t need to memorize all these elements and attributes. Most of the time, they are generated for
you automatically by VWD. In other cases, where you need to enter them by hand, VWD offers you
IntelliSense to help you find the right tag or attribute. IntelliSense is discussed in the next chapter.
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The Difference Between HTML and XHTML

In addition to HTML, you may also run into the term XHTML. Although the two have very simi-
lar names, they have some interesting differences that you need to be aware of. XHTML is a refor-
mulation of HTML in XML — eXtensible Markup Language. This is a generic, text- and tag-based
language used to describe data and is used as the base language for many other languages, including
XHTML.

So, XHTML is in fact largely just HTML rewritten with XML rules. These rules are pretty simple,
and most of the time VWD will help you get it right or show you a list of errors and suggestions on
how to fix them.

Always Close Your Elements

In XHTML, all elements must be closed. So when you start a paragraph with <p>, you must use
</p> somewhere later in your page to close the paragraph. This is also the case for elements that
don’t have their own closing tags, like <img> or <br> (to enter a line break). In XHTML, these tags
are written as self-closing tags, where the closing slash is embedded directly in the tag itself as in
<img src="Logo.gif" /> or <br />.

Always Use Lowercase for Your Tag and Attribute Names

XML is case sensitive, and XHTML applies that rule by forcing you to write all your tags in lowercase.
Although the tags and attributes must be in all lowercase, the actual value doesn’t have to be. So, the
preceding example that displays the logo image is perfectly valid XHTML, despite the uppercase L in
the image name.

Always Enclose Attribute Values in Quotes

Whenever you write an attribute in a tag, make sure you wrap its value in quotes. For example,
when writing out the <img> tag and its src attribute, write it like this:

<img src="Logo.gif" />

And not like this:

<img src=Logo.gif />

You could also use single quotes to enclose the attribute value, as in this example:

<img src='Logo.gif' />

It’s also sometimes necessary to nest single and double quotes. When some special ASP.NET syntax
requires the use of double quotes, you should use single quotes to wrap the attribute’s value:

<asp:Label ID="TitleLabel" runat="server" Text='<%# Eval ("Title") %>' />

You’ll see this syntax used a lot more in later chapters in this book.

For consistency, this book uses double quotes where possible in all HTML that ends up in the client.
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Nest Your Elements Correctly

When you write nested elements, make sure that you first close the inner element you opened last,
and then close the outer element. Consider this correct example that formats a piece of text with
both bold and italic fonts:

<b><i>This is some formatted text</i></b>

Notice how the <i> tag is closed before the <b> tag. Swapping the order of the closing tags leads to
invalid XHTML:

<b><i>This is some formatted text</b></i>

Always Add a DOCTYPE Declaration to Your Page

A poctTYPE gives the browser information about the kind of HTML it can expect. By default, VWD
adds a pocTyPE for XHTML 1.0 Transitional to your page:

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN"
"http://www.w3.org/TR/xhtmll/DTD/xhtmll-transitional.dtd">

The pocTyPE greatly influences the way browsers like Internet Explorer render the page. VWD’s
default pocTypPE of XHTML 1.0 Transitional gives you a good mix between valid markup and pages
that render the same in all major browsers.

NOTE |If you want to learn more about XHTML, get a copy of Wrox’s Beginning
Web Programming with HTML, XHTML, and CSS, 2nd Edition, ISBN: 978-0-470-
25931-3.

Besides HTML, an ASP.NET web page can contain other markup as well. Most pages will have one
or more ASP.NET Server Controls on the page to give it some additional functionality. The next
section briefly looks at these ASP.NET Server Controls, but you get an in-depth look at them in
Chapter 4.

A First Look at ASP.NET Markup

To some extent, the markup for ASP.NET Server Controls is similar to that of HTML. It also
has the notion of tags, elements, and attributes, using the same angle brackets and closing tags as
HTML does. However, some differences also exist.

For starters, most of the ASP.NET tags start with an asp: prefix. For example, a button in ASP.NET
looks like this:

<asp:Button ID="Buttonl" runat="server" Text="Click Me" />
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Note how the tag is self-closed with the trailing slash (/) character, eliminating the need to type a
separate closing tag.

Another thing you may have noticed is that the tag and attribute names are not necessarily in all
lowercase. Because an ASP.NET Server Control lives on the server, it doesn’t have to adhere to the
XHTML rules used in the browser at the client. However, when a Server Control is asked to emit its
HTML to a page that is configured to output XHTML, it will do so in XHTML. So, the code for
the same button looks like this when rendered in the browser as XHTML.:

<input type="submit" name="Buttonl" value="Click Me" id="Buttonl" />

Notice how the entire tag and its attributes conform to the XHTML standard. The process of con-
verting the Server Control to its HTML representation is similar to the code you saw earlier that
displayed the current date. The Server Control is processed at the server by the ASP.NET handler.
This processing results in HTML, which is sent to the browser where it’s displayed.

Now that you understand the basics of an ASP.NET page and the HTML that it generates, it’s time
to look at VWD again. Knowing how to use the application and its many tools and windows is an
important step in building fun, good-looking, and functional web sites.

A TOUR OF THE IDE

VWD is by far the most extensive and feature-rich integrated development environment (IDE) for
building ASP.NET web pages. The abbreviation IDE refers to the way all the separate tools you need
to build complex web applications are integrated in a single environment. Instead of writing code in
a text editor, compiling code at the command line, writing HTML and CSS in a separate applica-
tion, and managing your database in yet another, VWD enables you to perform all of these tasks,
and more, from the same environment. Besides the efficiency this brings because you don’t have to
constantly switch tools, this also makes it much easier to learn new areas of VWD, because many of
the built-in tools work in the same way.

The Main Development Area

To get familiar with the many tools that are packed in VWD?’s interface, take a look at Figure 1-8.
It shows the same screen you got after you created your first web site in VWD, but now it highlights
some of the most important screen elements. If you are already familiar with a previous version of
Visual Web Developer, you could skip this section and pick up again at the next Try It Out exercise
later in this chapter.

If you had a previous version of Visual Studio installed, your screen may look different, because
Visual Studio 2010 is able to import settings from older versions.
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FIGURE 1-8

Choosing Your Development Profile

Because Visual Web Developer Express targets people new to ASP.NET development as well as
seasoned web developers, you can choose among different developer profiles: Basic Settings, Code
Optimized, and Expert Settings. In Basic Settings mode, many menu items you don’t frequently use
have been hidden or are placed in their own sub menu. The Code Optimized profile is great for pure
coding sessions where you’re not interested in many of the design features of VWD. It hides items
like the Toolbox and the Properties Grid, both shown in Figure 1-8. Expert Settings mode gives you
access to the full functionality of VWD. You can switch between settings using the Tools ©> Settings
menu. This book assumes you are using Expert Settings mode right from the beginning. You may
not need all features you see right from the start but you sure will use most of them by the end of
the book. Since the menu items change location depending on the profile you choose, I decided to
use Expert Settings mode right away, to make it easier to refer to a specific menu item or feature.

The Main Menu

At the top of the application, right below the Windows title bar, you see the main menu. This menu
bar contains familiar items you find in many other Windows applications, like the File, Edit, and
Help menus as well as menus that are specific to VWD, such as the Website and Debug menus. The
menu changes dynamically depending on the task you’re working on, so you’ll see menu items appear
and disappear as you work your way through the application. You can use the Help = Manage Help
Settings menu to configure online and offline help. Offline helps needs to be installed first, while
online help requires a connection to the Internet.

The Toolbar Area

Right below the menu, you see the toolbar area that is capable of showing different toolbars that
give you quick access to the most common functions in VWD. In Figure 1-8, only two of the
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toolbars are enabled, but VWD comes with many other toolbars that you can use in specific task-
oriented scenarios. Some toolbars appear automatically when you’re working on a task that requires
a particular toolbar’s presence, but you can also enable and disable toolbars to your liking. To
enable or disable a toolbar, right-click an existing toolbar or the menu bar and choose the toolbar
from the menu that appears.

The Toolbox

On the left of the main screen, tucked away at the border of VWD, you see the tab for the Toolbox.
If you hover your mouse over the tab, the Toolbox folds out, giving you a chance to see what it
contains. If you click the little pin icon in the upper-right corner of the Toolbox (or any of the other
panels that have this pin icon), it gets pinned to the IDE so it remains open.

Just as with the menu bar and the toolbars, the Toolbox automatically updates itself to show con-
tent that is relevant to the task you’re working on. When you’re editing a standard ASPX page, the
Toolbox shows the many controls you have available for your page. You can simply drag an item
from the Toolbox and drop it on a location of your page where you want it to appear. These controls
are discussed in great detail in Chapter 4.

The Toolbox contains multiple categories with tools that can be expanded and collapsed as you see
fit to make it easier to find the right tool. You can also reorder the items in the list, add and remove
items from the Toolbox, and even add your own tools to it. Customizing the IDE is discussed later
in this chapter.

If the Toolbox is not visible on-screen, press Ctrl+Alt+X to open it or choose View =& Toolbox, pro-
vided you have chosen the Expert Settings option in the Tools = Settings menu.

The two additional tabs below the Toolbox tab, CSS Properties and Manage Styles, are discussed
extensively in Chapter 3.

The Solution Explorer

At the right of the screen, you see the Solution Explorer. The Solution Explorer is an important win-
dow because it gives you an overview of the files that comprise your web site. Instead of placing all
your files in one big folder, the Solution Explorer enables you to store files in separate folders, creat-
ing a logical and organized site structure. You can use the Solution Explorer to add new files to your
site, move existing files around using drag and drop or cut and paste, rename files and delete them
from the project, and more. Much of the functionality of the Solution Explorer is hidden behind its
right-click menu, which changes depending on the item you right-click.

At the top of the Solution Explorer, you see a small toolbar that gives you quick access to some
functionality related to your web site, including opening the Properties Grid for the selected item,
refreshing the Solution Explorer window, an option to nest related files, and two buttons that allow
you to copy and configure your web site. Most of this functionality is discussed later in the book.

You can access the Solution Explorer by choosing View = Solution Explorer from the main menu or
by pressing Ctrl+Alt+L.
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The Database Explorer

This window, hidden behind the Solution Explorer in Figure 1-8, enables you to work with
your databases. If you have a commercial version of Visual Studio, such as Visual Studio 2010
Professional, this window is called the Server Explorer and may be located at the left of your screen.

The Database Explorer is discussed in more detail in the chapters about databases, starting with
Chapter 12.

The Properties Grid

With the Properties Grid, you can view and edit the properties of many items in Visual Studio,
including files in the Solution Explorer, controls on a web page, properties of the page itself, and
much more. The window constantly updates itself to reflect the selected item. You can quickly open
the Properties Grid by pressing F4. This same shortcut can be used to force the Properties Grid to
show the details of a selected item.

The Document Window

The Document Window is the main area in the middle of the application. This is where most of the
action takes place. You can use the Document Window to work with many different document for-
mats, including ASPX and HTML files, CSS and JavaScript files, code files for VB and C#, XML and
text files, and even images. In addition, you can use the same window to manage databases, create
copies of your site, view the pages in your site in the built-in mini-browser, and much more.

At the bottom of the Document Window in Figure 1-8, you see three buttons called Design, Split,
and Source. These buttons appear automatically when you’re working with a file that contains
markup, such as ASPX and HTML pages. They allow you to open the Design View of a page (giv-
ing you an idea of how the page will look in the browser), its Markup View (the HTML and other
markup), or both at the same time. How this works is explained in more detail in Chapter 2, but for
now, it’s important to realize you can switch between Markup, Split, and Design View by clicking
the appropriate buttons. The Markup View is also often called the Source View or Code View win-
dow. However, to avoid confusion with the code editor that is used to edit Code Behind files, this
book uses the term Markup View exclusively.

The Document Window is a tabbed window by default, which means it can host multiple docu-
ments, each one distinguished by a tab with the file name at the top of the window. The right-click
menu of each tab contains some useful shortcuts for working with the file, including saving and clos-
ing it and opening the file’s parent folder in Windows Explorer.

To switch between documents, you can press Ctrl+Tab or you can click the down arrow in the
upper-right corner of the Document Window, next to the Solution Explorer, shown in Figure 1-8.
Clicking the down arrow reveals a list of open documents so you can easily select one.

Another way to switch documents is to press Ctrl+Tab and then hold down the Ctrl key. On the win-
dow that pops ups, you can select a document you want to work with in the right-hand column. You
can then use the cursor keys to move up and down in the list with open documents. This makes it
super easy to select the correct file.
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On the same dialog box, you see a list with all active tool windows. Clicking one of the windows in
the list will show it on-screen, moving it in front of other windows if necessary.

The Start Page

Whenever you start up VWD, the Start Page is loaded in the Document Window. With the Start
Page, you can quickly create new or open existing web sites and other projects. The Start Page also
provides a number of links to related news and information about web development.

To get a feel for how you can use all these windows, the following Try It Out shows you how to
build a simple web page that contains a few ASP.NET Server Controls.

Creating Your First ASP.NET Web Page

This Try It Out exercise guides you through creating a new web site with a single page that contains
a number of ASP.NET Server Controls. You see how to use windows like the Document Window and
the Solution Explorer, and how to use the Toolbox and the Properties Grid to add ASP.NET Server
Controls to the page and change their looks.

1.  Make sure Visual Web Developer 2010 is started.

2. If you're using the Express edition, choose Tools = Settings and choose Expert Settings to turn on
the developer profile that gives you access to the full feature set of VWD.

3.  On the File menu choose New Web Site. If you are using a commercial version of Visual Studio, you
may have to choose File ©> New &> Web Site instead. This triggers the New Web Site dialog box.

4. In this dialog, make sure that ASP.NET Empty Web Site is selected and not the ASP.NET Web Site
item that you used in a previous exercise. Ensure that File System is chosen in the Web Location
drop-down list. Click OK to create the new site.

5.  Next, right-click the new web site in the Solution Explorer. Make sure you click the uppermost ele-
ment that says something like c:\. . \website2\. It’s the highlighted element in Figure 1-4. From
the context menu that appears, choose Add New Item.

6. In the new window that appears, click Web Form and type ControlsbDemo as the name. The ASPX
extension is added for you automatically when you click the Add button. You can leave the other
settings in the dialog box at their default settings. The page should open in Markup View, showing
you the default HTML, like the <html>, <head>, <title>, and <body> elements that Visual Web
Developer adds there for you automatically when you create a new page.

7.  Switch the page to Design View by clicking the Design button at the bottom of the Document
Window.

8. If the Toolbox isn’t open yet, press Ctrl+Alt+X to open it or hover your mouse over the Toolbox

tab to show it and then click the pin icon to make the r_—
ContrghOrmoap® 5

Toolbox visible at all times. Drag a TextBox and a [k |

Button from the Toolbox into the dashed area in the |7ﬂ[
Design View of the page. You should end up with a

Design View that looks similar to Figure 1-9. FIGURE 1-9
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9. Right-click the button in Design View and choose [ =
Properties. In the Properties Grid, locate the Text property Bution], Jystem Wb L8 WebCentro Button
under the Appearance category (shown in Figure 1-10) g o8 ) [
and change it from Button to Submit Information. As g 3
soon as you press Tab or click somewhere outside the Y et rPcxrstian
Properties Grid, the Design View of the page is updated e e -
and shows the new text on the button. Tt

TR téaft 13 Bé (Bbwn an the Button
10. Press Ctrl+F5 to open the page in your default browser.

Note that it’s not necessary to explicitly save the changes FIGURE 1-10
to your page (although it’s a good idea to do this often any-

way using the shortcut Ctrl+S). As soon as you press

Ctrl+F5 to run the page, VWD saves all changes to open

documents automatically.

NOTE If you don't like this behavior, you can change it. Choose Tools &> Options
from the main menu. Then make sure that Show All Settings is checked, open the
Projects and Solutions node, and choose Build and Run. In the Before Building list,
you can change the way VWD behaves when you open a page in your browser.

11.  Type some text in the text box and click the button. Note that after the page has reloaded, the text
is still displayed in the text box. Other than that, not much has happened because you didn’t write
any code for the button yet.

How It Works

When you dragged the Button and the TextBox from the Toolbox on the page in Design View, VWD
added the corresponding code for you in Markup View automatically. Similarly, when you changed
the Text property of the button in the Properties Grid, VWD automatically updated the markup for
the control in Markup View. Instead of using the Properties Grid, you could also have typed the text
directly between the quotation marks of the Text property in Markup View.

After changing the Text property, your page should now contain this code in Markup View:

<asp:TextBox ID="TextBoxl" runat="server"></asp:TextBox>
<asp:Button ID="Buttonl" runat="server" Text="Submit Information" />

When you press Ctrl+F5 to view the page in the browser, the web server receives the request, the page is
processed by the ASP.NET runtime, and the resulting HTML for the page is sent to the browser.

After you type in some text and click the button, the same process is more or less repeated: the

web server receives the request, the page is processed, and the result gets sent back to the browser.
When you click the button, you cause a postback to occur, where any information contained in the
page — such as the text you typed in the text box — is sent back to the server. ASP.NET reacts to the
postback by rendering the page again. However, this time it prepopulates controls, like the TextBox,
with the values that were sent to the page.
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Take a look at the resulting HTML for the page using the browser’s View Source command (rerun the
page from VWD by pressing Ctrl+F5 if you already closed it). You should see code similar to this:
<input name="TextBoxl" type="text" value="Hello World" id="TextBoxl" />

<input type="submit" name="Buttonl" value="Submit Information" id="Buttonl" />

Just as with the earlier example, you can see that the resulting HTML is substantially different from the
original ASPX markup.

Postbacks are an important concept in ASP.NET, and you see more about them in other chapters,
including Chapters 4 and 9.

VWD hosts many more windows and tool panels than those you have seen so far. The next section
briefly touches upon some of the windows you’ll most frequently use when building ASP.NET web
pages. All of the windows mentioned are accessible from the main View menu in VWD if you’re
using the Expert Settings mode.

Informational Windows

In addition to the windows that are visible by default when you start VWD, many more windows
are available in VWD. You see most of them in action in the remainder of this book, but some are
worth highlighting now. You access all windows that are discussed next from the main View menu.

The Error List

The Error List gives you a list of the things that are currently somehow broken in your site, includ-
ing incorrect markup in your ASPX or HTML files and programming errors in VB or C# files. This
window can even show you errors in XML and CSS files. The Error List shows its messages in three
categories — Errors, Warnings, and Messages — that signify the severity of the problem. Figure 1-11
shows the error list for a page that has some problems with its CSS and XHTML.
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FIGURE 1-11

The Output Window

When you try to build your site using the Build menu, the Output window tells you whether or not
the build succeeded. If the build failed, for example because you have a programming error, it tells
you why the build failed. In the commercial versions of Visual Studio, the Output window is used
for other information as well, including the status of external plug-in programs. Building — or com-
piling — web sites is discussed later in this book, including Chapter 19, which deals with deploy-
ment of your web site.
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The Find Results Window

The Find and Replace features of VWD are invaluable tools when it comes to managing the content
of your site. You will often need to replace some text in the current document or even in the entire
site. Find in Files (Ctrl+Shift+F) and Replace in Files (Ctrl+Shift+H) both output their results in the
Find Results window, as shown in Figure 1-12.
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Because having several informational windows open at the same time may take up precious screen
space, it’s often a good idea to dock them. This way, only one of them is visible at a time, while you
still have quick access to the others. You learn how to customize the IDE, including the docking of
windows, next.

CUSTOMIZING THE IDE

Although the standard setup of VWD and its tool windows is pretty useful, there’s a fair chance
you want to customize the IDE to your liking. You may want to rearrange some of the windows to a
location where they are easier to reach, or you may want to open additional windows you frequently
use. VWD is fully customizable and enables you to tweak every little detail of the IDE. In the next
section, you learn how to perform the most common customization tasks.

Rearranging Windows

To give each window the location it deserves, you can drag and drop them in the main IDE. Simply
grab a window’s title bar or its bottom tab and drag it in the direction of the new location. Once
you start dragging, you’ll see that VWD gives you visual cues as to where the window will end up
(see Figure 1-13).

If you drag the window over one of the four square indicators at the sides of the indicator, VWD
shows a preview of how the window will be docked next to an existing window. Once you drop it,
the window will pop to its new location. If you drop the window on the square in the middle of the
large indicator, the window will dock with that window, sharing the same screen space. Each win-
dow has its own tab, as can be seen with the windows at the bottom of Figure 1-13.

In addition to docking windows with others in the IDE, you can also have floating windows. To
change a docked window into a floating one, either drag it away from its current location and drop
it somewhere in the IDE without hitting one of the visual cues on the screen or choose Window =
Float from the main menu.
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FIGURE 1-13

To restore a floating panel to its previous docked location, choose Window = Dock from the
main menu. Make sure you don’t choose Dock as Tabbed Document for the tool windows like the
Toolbox or the Solution Explorer or they’ll end up in the main Document Window. This makes it
difficult to use these tool windows together with an open file as the two windows will share the
same space.

Modifying the Toolbox

The Toolbox can be modified as well. By default, the items are sorted alphabetically but you can
reorder them using drag and drop. To do this, open the Toolbox (press Ctrl+Alt+X), and drag an
item (such as the TextBox under the Standard category) to a different location. You can also delete
items from the Toolbox by right-clicking them and choosing Delete from the context menu. Don’t
worry about items getting lost forever; you can reset the Toolbox again by choosing Reset Toolbox
from the same menu.

You can also add your own items to the Toolbox. The most common use for this is code snippets. Simply
highlight some text or code in the Document Window and drag it to the Toolbox. You can then right-
click the item and choose Rename Item to give it a more meaningful name that you can easily recognize.

To avoid cluttering up the Toolbox with your own code snippets, consider creating a separate cat-
egory for them. You can do this by choosing Add Tab from the Toolbox’s right-click menu. Enter a
name and press Enter, and your Toolbox tab is ready for use.
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In the next Try It Out exercise, you get the chance to play around with the VWD IDE so you can
customize it to your liking.

Customizing the IDE

In this exercise you practice with opening and rearranging the windows in the Visual Web Developer
IDE. Don’t be afraid to mess up the IDE. A little later in this chapter, instructions are given on how to
reset the IDE to the way it was when you opened it the first time.

1.

2.

10.

If you closed your web site since the previous Try It Out, open it again, or create a new one using
the File menu.

From the View menu, choose Error List to open the Error List window. If you don’t see the Error
List item directly, choose Tools = Settings & Expert Settings first. Notice how the Error List gets
docked below the Document Window by default.

From the same View menu, choose Task List. By default, it will be docked in the same space as the
Error List, with the tabs for both windows next to each other.

Click the tab of the Task List and while holding down your mouse button, drag the Task List away
from its location in the direction of the Document Window. Once you release the window, it will
appear as a floating window in the IDE. To restore the window, right-click its title bar and choose
Dock. Notice how the tab returns to the same tab group, but possibly at a different position. To
change the order in which tabs appear in a tab group, drag a tab over the other tabs and release it
at the desired location.

If you want, you can repeat the previous steps for other windows that are visible in the IDE by
default or for the ones you find under the View menu. Spend some time familiarizing yourself with
all the different windows and how you can arrange them on-screen. Because you’ll be working a lot
with these windows in the remainder of this book, it’s good to be familiar with their locations.

Next, open the ControlsDemo.aspx page (or add a new ASPX first if you created a new web site)
from the Solution Explorer by double-clicking it. When the page opens, the Toolbox becomes vis-
ible automatically. If it doesn’t, press Ctrl+Alt+X to open it.

Right-click the Toolbox and choose Add Tab. Type HTML Fragments as its new name and press
Enter. This adds a new category to the Toolbox that behaves just like all the others.

With the Document Window showing your ASPX page in Markup View, type <h1> directly after
the opening <div> tag. Note that VWD automatically inserts the closing </h1> for you. You should
end up with code in Markup View looking like this:
<form id="forml" runat="server">
<div>
<hl></hl>
</div>

Highlight the opening and closing <h1> tags, and then drag the selection from the Markup View win-
dow onto the new Toolbox tab you created in step 7. The selection shows up as Text: <h1></h1>.

Right-click the Toolbox item you just created, choose Rename Item, and type Heading 1 as
the name.
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11. Put your cursor in the Document Window again and press Ctrl+K directly followed by Ctrl+D to
format the document in the Document Window. Alternatively, choose Edit & Format Document
from the main menu. This formats the document according to the rules you have set in the Text
Editor options dialog. Formatting is also available for a number of other document types, including
C# and VB.NET code and XML files.

From now on, whenever you need a heading in your document in Markup View, simply place the cur-
sor in the Document Window where you want the heading to appear and double-click the appropriate
heading in the Toolbox.

How It Works

Most of the steps in this Try It Out are self-explanatory. You started off by opening a few windows that
you frequently need when building web sites. You then used the drag-and-drop features of the IDE to
rearrange the window layout to your personal preferences.

You then added an HTML fragment to a custom tab in the Toolbox. When you drag any markup to
the Toolbox, VWD creates a Toolbox item for it that contains the selected markup. Whenever you
need a copy of that markup in your page, simply double-click the item or drag it from the Toolbox into
Markup View. This is a great time saver for HTML fragments that you frequently use. You typically
use this technique for larger blocks of code; for elements like the <n1> VWD has a better tool called
Code Snippets, which you meet later in this book.

At the end you used VWD’s document formatting option to change the layout of the code in the docu-
ment. This helps to keep the code organized and easier to read. You can fully change how the code is
formatted by using the options dialog accessible through Tools &> Options. Then expand the path Text
Editor ©» HTML = Formatting, and click Tag Specific Options.

Besides the Window layout and the Toolbox, VWD enables you to customize a lot more in the IDE.
The following section explains how to customize three other important IDE features: the Document
Window, toolbars, and keyboard shortcuts.

Customizing the Document Window

Visual Web Developer gives you great flexibility with regard to how text is displayed in the
Document Window. You can change things like font size, font color, and even the background color
of the text. You can access the Font and Colors settings by choosing Tools &> Options, making sure
that Show All Settings at the bottom of the dialog box is selected, and then choosing Environment =
Fonts and Colors.

One thing I like to customize in the Document Window is the tab size, which controls the number
of spaces that are inserted when indenting code. To change the tab size, choose Tools = Options,
and then under Text Editor choose All Languages = Tabs. If you don’t see this option, choose Show
All Settings at the bottom first. I usually set the Tab and Indent Size to 2 spaces, leaving the other
settings in the Tab panel untouched. Another thing I like to customize is the number of line breaks
before and after HTML elements. The Options window gives you full control over this by selecting
Text Editor & HTML = Formatting and then clicking Tag Specific Options.
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With the exception of the Tab Size being set to 2 and the number of line breaks around a few
HTML elements, all screen shots in this book show the default setup of Visual Web Developer.

Customizing Toolbars

Toolbars can be customized in three ways: you can show or hide the built-in toolbars, you can add
and remove buttons on existing toolbars, and you can create your own toolbars with buttons you
often use.

Enabling and Disabling Toolbars

You disable and enable existing toolbars by right-clicking any existing toolbar or the menu bar and
then selecting the appropriate item from the list. Once the toolbar is displayed, you can use its drag
grip at its left to drag it to a new location within the Toolbar area.

Editing Existing Toolbars

If you feel that an existing toolbar is missing an important button or that it contains buttons you
rarely use, you can customize the buttons on the toolbar. To do this, right-click any toolbar or

the menu bar, choose Customize, switch to the Commands tab and select the toolbar you want to
modify from the Toolbar drop-down. With the command buttons at the right, you can add new and
remove existing commands, or change their order.

If you want to move a toolbar to the left, right or bottom of the window, switch back to the
Toolbars tab of the Customize window, select the toolbar and click Modify Selection.

Creating Your Own Toolbars

Creating your own toolbar is useful if you want to group some functions that you frequently use. To
create a new toolbar, open the Customize window as explained in the preceding section. Click the
New button and type a name for the toolbar. Then switch to the Commands tab and modify your
toolbar as you would do with existing toolbars.

Customizing Keyboard Shortcuts

Another setting many developers like to change is keyboard shortcuts. Keyboard shortcuts are a
good way to save time because they allow you to perform a task with a simple keyboard command
instead of reaching for the mouse and selecting the appropriate item from the menu. To change the
keyboard shortcuts, choose Tools = Options, expand Environment, and click Keyboard. Locate
the command for which you want to change the shortcut in the list with commands. Because this
list contains many items, you can filter the list by typing a few letters from the command. For
example, typing print in the Show Commands Containing field gives you a list of all print-related
commands.

Next, in the Press Shortcut Keys field, type a new shortcut and click Assign. VWD allows you to
enter a double shortcut key for a single command. For example, you can bind the command Close
All Documents to the command Ctrl+K, Ctrl+O. To perform this command, you need to press both
key combinations in rapid succession. Although a double shortcut key may seem like overkill, it
greatly increases the number of available shortcut keys.
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Resetting Your Changes

Don’t worry if you feel that you have messed up VWD by trying out the numerous customization
options. You have many ways to restore VWD to its previous state.

Resetting the Window Layout

This setting, accessible from the Window menu, resets all windows to the position they were in
when you first started VWD. This command is useful if you misplaced too many windows and
ended up with a cluttered IDE.

Resetting the Toolbox

If you removed an item from the Toolbox by mistake or even deleted an entire tab, you can reset the
Toolbox to its original state by right-clicking the Toolbox and choosing Reset Toolbox. You need to
think twice before you use this command because it will also delete all your custom code snippets.

Resetting All Settings

If you followed along with the previous Try It Out exercises, and then started experimenting with
the customization possibilities, your IDE is now probably in one of two states: it either looks exactly
the way you want it, or it looks like a complete mess. In the latter case, it’s good to know that it is
easy to clean up the chaos.

To completely revert all VWD settings to the way they were right after installation, choose Tools @
Settings & Import and Export Settings or Tools & Import and Export Settings, depending on the
version of Visual Web Developer you're using. Next, choose the Reset All Settings option and click
Next. If you want, you can create a backup of the existing settings; otherwise, choose No, Just Reset
Settings. You get another screen that enables you to choose among a number of settings collections.
Choose Expert Settings or Web Development because these options give you access to all features
you need to follow along with this book. Finally, click Finish. This action will cause all settings

to be reset to their defaults, including the Windows layout, Toolbox and Toolbox customizations,
shortcut keys, and everything you may have changed in the VWD Options dialog box. So, use this
command only when you’re really sure you want a fresh, new setup of VWD.

With some basic knowledge about ASP.NET pages and VWD, it’s time for some real action. In the
next chapter, you see how to create ASP.NET web sites and web pages in much more detail. You
learn how to organize your site in a logical and structured way, how to add the many different types
of files to your site and how to use them, and how to connect the pages in your site.

However, before you proceed to the next chapter, there is one more important topic you need to
look at: the sample application that comes with this book.

THE SAMPLE APPLICATION

Building web sites is what this book is all about, so it makes a whole lot of sense that this book
comes with a complete and functional sample site that is used to showcase many of the capabilities
of ASP.NET.
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The sample site you build in this book is called Planet Wrox, a site that serves as an online commu-
nity for people interested in music. The site offers the following features to its visitors:

> Reviews about CDs and concerts that have been posted on the site by the administrator.
> The Gig Pics section, an online photo album where users can share pictures taken at concerts.

> The ability to switch between the different graphical themes that the site offers, giving you a
chance to change the look and feel of the site without altering the content.

> Store musical preferences that influence the information users see on the site.

> Access to bonus features for registered users.
From an administrative perspective (that is you, as the owner of the site) the site enables you to do
the following:

»  Add and maintain the reviews.

> Manage the different musical genres in the system.

> Manage photo albums created by visitors to the site.

Figure 1-14 shows the Planet Wrox home page.
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Figure 1-15 shows another page from Planet Wrox, but with a different theme applied. This page
enables users to enter their personal information and specify preferences with regard to their favorite
musical genres.
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You can find an online running example of the site at www.PlanetWrox.com. There you can play
around with the site from an end user’s perspective.

You can also download the source for the sample application and all other examples from this book

from the Wrox web site at www.wrox.com.

By the end of this book, you’ll be able to build all of the functionality from the sample site (and
hopefully even more) in other web sites. Don’t worry if it sounds like an awful lot of complex things.
I guide you, step by step, from the beginning of the application all the way to the last feature. As
long as you keep having fun doing this, I'm sure you’ll make it all the way.

PRACTICAL TIPS ON VISUAL WEB DEVELOPER

Most of the chapters in this book end with a short section of useful tips. These are tips that either
didn’t fit in anywhere in the text or that encourage you to further explore or test out things. Sometimes
they may seem irrelevant or hard to understand at first, but you’ll find that as you make your way
through this book and look back at tips from previous chapters, things start to make sense. Don’t
worry if you don’t understand certain things completely the first time you see them. Give the idea some
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thought and revisit the topic a few days later. Hopefully, by letting the ideas sink in a little, things start to
make more sense automatically. This applies not only to the Practical Tips section, but to the entire book.

> Before you move on to the next chapter, play around with VWD some more. Add a couple
of pages to your site, drag and drop some controls from the Toolbox onto your pages, and
view them in your browser. That way, you’ll have a better understanding of the tools and the
many controls available when you start the next chapter.

> Familiarize yourself with the many options to tweak the Visual Web Developer IDE. When
building web sites, you spend most of your time in this IDE, so it makes sense to tweak it as
much as possible to your liking. Don’t be afraid to mess it up; you can always revert to previ-
ous settings.

> Take some time to browse through the settings you find in the Options dialog box of VWD
(accessible through the Tools => Options menu). Many of the settings are self-explanatory
and can really help in further tweaking the IDE to your liking.

SUMMARY

This chapter covered a lot of important ground to get you started with ASP.NET 4 and VWD 2010. It
started off with a brief history of the Microsoft .NET Framework in general and ASP.NET in particular.

You then learned how to acquire and install Visual Web Developer 2010 Express. VWD is the most
extensive and versatile tool available for creating ASP.NET 4 web pages. To enable you to work with
it effectively, this chapter showed you how to use and customize the main features of the IDE. In sub-
sequent chapters, you use and extend this knowledge to work with the many tools found in VWD.

It’s important to understand how a page in VWD makes it to your web browser. Some knowledge
of the web server that serves the request and how the page is processed to deliver the final HTML in
the browser is critical in understanding ASP.NET. This chapter gave you a short introduction in the
way a web page is requested and served to the browser.

In the next chapter, you get a much more detailed explanation of creating web sites.

EXERCISES

Explain the differences between the markup of a page in VWD and the final HTML page in the browser.
Explain the difference between HTML and XHTML. How are the two related?

Imagine you have a number of HTML fragments that you expect to use a lot throughout the site.
What’s the best way to make these fragments available in VWD?

What are three of the ways you can reset part or all of the IDE customization settings?

If you want to change the property of a control on your page, for example the text of a button,
which two options do you have available to make the change?

Answers to Exercises can be found in Appendix A.
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» WHAT YOU LEARNED IN THIS CHAPTER

Attribute
Element

HTML

HTTP

IDE

JavaScript

Tag
Visual Studio 2010

Visual Web
Developer

XHTML

Extra information in a tag to define or change its behavior
A pair of tags holding some text or other content

HyperText Markup Language: the language that browsers use to display a
web page

HyperText Transfer Protocol: the protocol by which web browsers and web
servers communicate

Integrated Development Environment: an integrated collection of applica-
tions and tools to develop applications

A programming language used to interact with a web page in the client’s
browser

Text surrounded by angle brackets to create HTML elements
The development environment to build .NET applications

The part of Visual Studio (but also available separately as the free Express
edition) that enables you to build ASP.NET web applications

HTML rewritten with XML rules

CONFER PROGRAMMER TO PROGRAMMER ABOUT THIS TOPIC.






Building an ASP.NET Web Site

WHAT YOU WILL LEARN IN THIS CHAPTER:

> The different project types you can choose from as a starting point
for your ASP.NET web sites

> The different project templates that are available to jumpstart your
site development

»  The numerous file types available in ASP.NET and what they are
used for

> Ways to create structured web sites that are easy to manage, now
and in the future

> How to use the designer tools to create formatted web pages

To create good-looking, functional, and successful web sites, you have to understand a
number of important technologies and languages, including (X)HTML, ASP.NET, CSS
(Cascading Style Sheets), a server-side programming language such as C# or VB, and a client-
side language such as JavaScript. This and upcoming chapters provide a solid foundation

in these technologies, so you should be comfortable with the most important concepts once
you’ve finished this book.

Besides these technologies, you also have to understand the Visual Web Developer IDE that
was introduced in the previous chapter. You need to know how to create sites, add pages, and
manage all the toolbars and windows that Visual Web Developer (VWD) offers you. In addi-
tion, you need to know how to build and design web pages in VWD with HTML and Server
Controls.

This chapter shows you, in detail, how to create and manage your web sites. It also shows you
how to create your ASP.NET web pages and add markup to them, enabling you to create use-
ful web pages that can present information to users and react to their response.
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Although you already created your first ASP.NET web site in the previous chapter, this chapter
starts off with another in-depth look at creating a new web site. Because you have many choices to
make when you start a new site, it’s important to understand all the different options and pick the
right one for your scenario.

CREATING WEB SITES WITH VWD 2010

The previous chapter gave you a quick overview of creating a web site in VWD. You simply chose New
Web Site from the File menu, selected a language, selected the standard ASP.NET Web Site template,
and clicked OK. However, there’s more to the New Web Site dialog box than you saw in the previous
chapter. You may have noticed that you can choose among a number of different templates that enable
you to create different kind of sites. But before looking at the different templates on which you can
base your new web site, you need to know a little more about the different project types that are avail-
able in VWD.

Different Project Types

In the initial release of Visual Web Developer 2008 Express you could only use one project type:
the Web Site Project. You needed one of the commercial versions of Visual Studio in order to use
the second project type — the Web Application Project. In August 2008, Microsoft released Service
Pack 1 for Visual Web Developer 2008, which gave users of the free Express edition access to the
Web Application Project template as well. This addition is still present in VWD 2010 so you now
have two options to choose from. Both project types are discussed next.

Web Site Projects

Web Site Projects represent a project in VWD for a web site. You create a new Web Site Project by
choosing File ©> New Web Site or File &> New > Web Site from Visual Web Developer’s main menu.

Web Site Projects were introduced in Visual Studio 2005 and provide some new flexibility in creat-
ing and working with web sites. In contrast to web sites built with earlier versions of Visual Studio
.NET, a Web Site Project site is simply a Windows folder with a bunch of files and subfolders in

it. There is no collective file (known as the project file with a .vbproj or .csproj extension) that
keeps track of all the individual files in the web site. You just point VWD to a folder, and it instantly
opens it as a web site. This makes it very easy to create copies of the site, move them, and share
them with others, because there are no dependencies with files on your local system. Because of the
lack of a central project file, Web Site Projects are usually simply referred to as web sites, which is
the term I use in the remainder of this book

Besides a lot of positive feedback on this move, Microsoft also received a lot of negative response
from developers who complained that Web Site Projects were too limiting for their development
environment. Because there is no container file that keeps track of everything in the site, it became
much harder to exclude files or folders from the site and work with source control systems — a cen-
tralized system that enables developers to work on a project collaboratively and that keeps track of
changes in the project automatically. Also, Web Site Projects influenced the way web sites are com-
piled and deployed, making it harder for developers accustomed to the previous model to apply their
knowledge and skills to the new project type.
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In response to the criticism, Microsoft released the Web Application Project template in May 2006
as an add-on for Visual Studio 2005 Standard Edition and up. The Web Application Project is now
an integral part of all versions of Visual Web Developer, free and commercial.

Web Application Projects

Web Application Projects make it easier for developers who work in teams or who need more con-
trol over the contents of the site and their compilation and deployment processes to build web sites
with VWD, because the whole web site is managed as a project with a single project file that keeps
track of all the content of the web site.

In VWD 2010, you create a new Web Application Project through the File = New Project dialog box.
In that dialog box, click your preferred programming language (either Visual Basic or Visual C#) and
click the Web category, where you’ll find a number of ASP.NET web application templates. One of
the available project templates is the ASP.NET MVC 2 Web Application, which creates an application
based on the Model View Controller pattern, another popular style of web application development.
MVC is not used or discussed in this book, but if you want to learn more, check out Beginning
ASP.NET MVC 1.0 by Simone Chiaretta and Keyvan Nayyeri (ISBN: 978-0-470-43399-7).

This book uses the Web Site Project model because it’s easier to work with if you’re new to ASP.NET.
However, you’ll find that sites built using the Web Application Project template have a lot in common
with Web Site Projects. You need to use the Web Site Project template if you want to follow along
with this book. When not referring to a specific project type, I'll use the terms web site and web
application interchangeably throughout this book when referring to web sites in general.

Now that you know about the different project types, the next thing to consider is the different web
site templates and their options.

Choosing the Right Web Site Template

The New Web Site dialog box in VWD contains different web site templates, each one serving a dis-
tinct purpose.

Figure 2-1 shows the New Web Site dialog box in VWD. You can open this dialog box by choosing
File & New Web Site, or File &> New > Web Site depending on your version of VWD. If your dialog
doesn’t look like Figure 2-1, make sure you chose File &> New Web Site and not accidentally File =
New Project.

In the left-hand section you can choose between Visual Basic and Visual C# as the programming
language for your site. The section in the middle shows the ASP.NET web site templates that are
installed by default. Each of them is discussed in the next section. When you have created your own
templates (which you learn how to do in Chapter 6), or have templates installed from other parties,
they show up in this area as well.

The ASP.NET Empty Web Site template is used throughout this book for the Planet Wrox web
site. The others are described briefly in the following sections so you know how they can be used.
The exact list of installed templates on your system depends on the version of Visual Studio

and the installed components. Don’t worry if you have other templates as long as you have the
ASP.NET Web Site and the ASP.NET Empty Web Site items.
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FIGURE 2-1

ASP.NET Web Site

This template enables you to set up a basic ASP.NET web site. It contains a number of files and fold-
ers to jump start the development of your site. The different file types are all discussed later in this
chapter. The special app_Data folder and the functionality of the pages in the Account folder are
discussed later in this book.

This template is a good starting point once you start developing real-world ASP.NET web sites.

ASP.NET Empty Web Site

The ASP.NET Empty Web Site template gives you nothing but a single configuration file (web
.config). The ASP.NET Empty Web Site template is useful if you have a bunch of existing files you
want to use to create a new web site or when you want to create your site from scratch. You use this
template as the basis for the sample web site you build in the book and add files and folders as you
progress through the book.

WCF Service

This template enables you to create a web site containing one or more WCF Services. A WCF
Service is somewhat similar to a web service in that it enables you to create methods that are
callable over a network. You see how to create and consume a web service from a browser in
Chapter 10. However, WCF Services, or Windows Communication Foundation Services go
much further than simple web services and offer you a lot more flexibility. WCF Services are
outside the scope of this book, but if you want to learn more about them, pick up the book
Professional WCF Programming: .NET Development with the Windows Communication
Foundation by Scott Klein (ISBN: 978-0-470-08984-2).
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Dynamic Data Web Sites

The two templates for Dynamic Data enable you to create a flexible yet powerful web site to manage
data in a database without a lot of manual code. These templates are not discussed in this book, but
you learn more about the Microsoft ADO.NET Entity Framework that one of the templates uses in
Chapter 14.

Although it seems you have to make a clear choice up front for the right web site template, this isn’t
really the case. Because an ASP.NET web site in VWD is essentially just a reference to a folder, it’s
easy to add types from one template to another. For example, it’s perfectly acceptable (and very
common) to add a web service file to a standard ASP.NET Web Site or an ASP.NET Empty Web
Site, as you see in Chapter 10.

Creating and Opening a New Web Site

There are a number of different ways to create new and open existing web sites. The choices you
have here are largely influenced by the way you access the web site (either from the local or a remote
machine), and whether you want to use the built-in web server that ships with VWD or use the web
server that comes with Windows.

All the examples in this book assume that you open sites from your local hard drive and that you
use the built-in web server, because it’s very convenient to develop sites with it. However, Chapter 19
shows you how to use and configure Internet Information Services, or IIS for short, the advanced
web server that comes with most editions of Windows. IIS is mostly used for production hosting of
your web sites, because it’s capable of serving web pages in high-traffic scenarios.

Creating New Web Sites

The next Try It Out section guides you through creating the Planet Wrox web site that is the project
you work on in this book. All exercises in the remainder of the book assume you have this web site
open in VWD, except where stated otherwise. The exercise instructs you to store your web site in a
folder called c: \BegasPNET\site. Take note of this folder name, because it’s used throughout this
book. If you decide to use a different folder, be sure to use your own location whenever you see this
folder name in the book. Also make sure you don’t use special characters like the hash (#) or insert a
space in the folder name because you’ll run into troubles when developing your site.

Creating a New ASP.NET 4 Web Site

1. Start by creating a folder called BegaSPNET in the root of your C drive using Windows Explorer
or My Computer. Inside the folder, create another folder called site. You should end up with a
folder called c:\BegaspPNET\Site. If you followed the instructions from the “Introduction” sec-
tion of this book and unpacked the source for this book, you already have the BegaspnET folder,
which in turn contains the source and Resources folders. You still need to create the site folder
though. If you want to follow along with VB.NET and C# at the same time, you can create two
folders: BegASPNETVB and BegASPNETCS and use two instances of VWD.
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7.

Start Visual Web Developer 2010 and choose File = New Web Site or File &> New = Web Site,
depending on your version of VWD.

COMMON MISTAKES Don’t mistakenly create a new Web Application Project
using File = New Project as this project template is not compatible with the
exercises in this book.

In the Installed Templates area on the left, choose between Visual Basic and Visual C#. All the examples
in this book are shown in both programming languages, so you can choose the one you like best.

In the area in the middle select ASP.NET Empty Web Site.

In the Web Location drop-down list, make sure that File System is selected. The other two options
(HTTP and FTP) enable you to open a remote site running IIS with the so-called Microsoft
FrontPage Server Extensions and open a site from an FTP server, respectively.

Click the Browse button next to the location text box, browse to the folder you created in the first
step of this exercise, and click Open.

Your final screen should look like the one in Figure 2-2, except that you may have chosen Visual
C# instead of Visual Basic.
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Click OK and VWD creates the new site for you.
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How It Works

As soon as you click OK, VWD creates a new, empty web site for you. This new [ =i
. . . . ) Wl dalEme I

web site contains nothing but a configuration file (called web.config.) In the P CABepASPNITVoRe,

Solution Explorer, your web site now looks like Figure 2-3. 8 wetconia

Because a web site based on the Empty Web Site template is just a simple FIGURE 2-3

Windows folder that VWD looks at, the actual folder on disk contains the same
file. No additional files are used to create the site, as shown in Figure 2-4, which
shows a Windows Explorer displaying the files in the folder c: \BegASPNET\Site.
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If you don’t see the .config extension of the web file, don’t worry. You see how to view file exten-
sions in a later exercise.

As you progress through this book, you’ll add new files and folders to the site. These additional
files and folders show up in the Solution Explorer and will appear in the Windows folder at
C:\BegASPNET\Site as well.

Opening web sites based on the Web Site Project template is very similar to creating new ones. In the
next section, you get a quick overview of opening existing sites in VWD.

Opening Existing Web Sites

Just as with creating new sites, opening an existing site in VWD gives you a few options with regard
to the source location of the web site. You can choose to open a site from the local file system, from
a local TIS web server, from a remote server using FTP, or from a remote site using the Microsoft
FrontPage Server Extensions. Figure 2-5 shows the Open Web Site dialog box in VWD.

All the examples in the book assume that you always open the Planet Wrox web site from the local
file system, using the File System button, which is the first button in the left column of the window.
Then in the right pane, locate your web site (C: \BegASPNET\Site in this example) and click the
Open button.
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The site you created in the previous Try It Out is a very bare-bones site. To make it more useful,
you’ll need to add files to it. The many file types you have at your disposal and the way they are
added to the site are the next topics of discussion.
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WORKING WITH FILES IN YOUR WEB SITE

An ASP.NET 4 web site consists of at least a single Web Form (a file with an .aspx extension), but
usually it consists of a larger number of files. Many different file types are available in VWD, each
offering a distinct functionality. In the next section, you see the most important file types that are

used in VWD. In addition, you learn a few different ways to add these files to your site.

The Many File Types of an ASP.NET 4 Web Site

To give you an idea of how many different files you can use in ASP.NET, Figure 2-6 shows the dia-
log box that enables you to add new files to the site (accessible by right-clicking your web site in the
Solution Explorer and choosing Add New Item or by choosing Website & Add New Item from the
main menu).

The files you can add to a site can be grouped in a few different categories. The most important
files — the ones you’ll use throughout the examples in this book — are discussed next.
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Web Files

Web Files are specific to web applications and can either be requested by a browser directly, or are
used to build up part of the web page that is requested in the browser. The following table lists the
various web files and their extensions, and describes how each file is used.

FILE TYPE EXTENSION DESCRIPTION

Web Form .aspx The workhorses of any ASP.NET web site, Web Forms rep-
resent the pages that your users view in their browser.

Master Page .master Enable you to define the global structure and the look
and feel of a web site. You see how they can be used in
Chapter 6.

Web User Control .ascx Contains page fragments that can be reused in multiple
pages in your site. Chapter 8 is entirely devoted to user
controls.

HTML Page .htm/ .html Can be used to display static HTML in your web site.

Style Sheet .css Contains CSS code that enables you to style and format your

web site. You learn more about CSS in the next chapter.

continues
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(continued)

FILE TYPE EXTENSION DESCRIPTION

Web Configuration .config Contains global configuration information that is used

File throughout the site. You see how to use the web.config
later in this book, starting with Chapter 4.

Site Map .sitemap Contains a hierarchical representation of files in your site in
an XML format. The Site Map is used for navigation and is
discussed in Chapter 7.

JScript File .Js Contains JavaScript (which Microsoft calls JScript) that can
be executed in the client’s browser.

Skin File .skin Contains design information for controls in your web site.

Skins are discussed in Chapter 6.

The next Try It Out exercise shows you how to add a new master page to the site, which is used
throughout the book.

Adding Files to Your Site

1.

2.

If it is not still open, open the Planet Wrox web site you created earlier by choosing File &> Open
Web Site. Make sure that you open the site from the File System, locate the folder that contains your
site (C: \BegASPNET\Site), and click the Open button.

In the Solution Explorer, right-click your site and choose New Folder as shown in Figure 2-7.

COMMON MISTAKES Make sure you click the actual site and not the
web.config file or you won’t get the correct menu item.

Sehstizn Liplors -0
Type MasterPages as the name of the folder and press Enter. ! ,:'J.:J..,:m.._
Then right-click this new folder and choose Add New Item. B (RN
Alternatively, you can choose File &> New File or Website 3 :l":,-,.. iy
Add New Item from Visual Web Developer’s main menu. i e Foiger b
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In the dialog box that appears, choose Master Page and type 2l Enterence

Frontend as the name. VWD automatically adds the .master i

extension for you when you add the file. Verify that under T coqwinia

Installed Templates you have selected the language you want e e

to use for this site and that Place Code in Separate File in the = St i
bottom right corner is checked. Finally, click the Add button. T] wetreen Fasses

The master page is added to the site, and is opened automati-
cally for you in the Document Window.
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FIGURE 2-7
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How It Works

This simple exercise showed you how to add a new item to your web site. Although at this stage the
site isn’t very exciting yet, the file you added forms the basis for the rest of the book. The next sections

briefly look at the remainder of the file types.

Code Files

Adding code files to the site is identical to how you add web files. The following table describes the
various types of code files.

FILE TYPE

Web Service

Class

Global Application
Class

EXTENSION

.asmx

.cs/ .vb

.asax

DESCRIPTION

Can be called by other systems, including browsers, and
can contain code that can be executed on your server.
Web services are covered in Chapter 10.

Can contain code to program your web site. Note that
Code Behind files (discussed later) also have this exten-
sion because they are essentially class files. C# uses files
with the . cs extension and Visual Basic uses .vb files.

Can contain code that is fired in response to interesting
things that happen in your site, such as the start of the
application or when an error occurs somewhere in the site.
You see how to use this file in Chapter 18.

Besides the Code Files category, there is one more group of files worth looking into: Data Files.

Data Files

Data Files are used to store data that can be used in your site and in other applications. The group
consists of the XML files, database files, and files related to working with data.

FILE TYPE

XML File

SQL Server
Database

EXTENSION

.xml

.mdf

DESCRIPTION

Used to store data in XML format. In addition to plain XML
files, ASP.NET supports a few more XML-based files, two
of which you briefly saw before: web.config and the
Site Map.

Files with an .mdf extension are databases that are used
by Microsoft SQL Server. Databases are discussed in
Chapter 12 and later.

continues
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(continued)
FILE TYPE EXTENSION DESCRIPTION
ADO.NET Entity .dbml Used to access databases declaratively, without the need
Data Model to write code. Technically, this is not a data file, because

it does not contain the actual data. However, because it is
tied to the database so closely, it makes sense to group

it under this header. You learn more about the ADO.NET
Entity Framework in Chapter 14.

As you saw in the previous Try It Out, adding a new file of any of these types is really easy. It’s just
as easy to add existing files to the site.

Adding Existing Files

Not every file you create in your web site has to be brand new. In some cases it makes sense to
reuse files from other projects. For example, you may want to reuse a logo or a CSS file across mul-
tiple sites. You can easily add existing files by right-clicking the web site in the Solution Explorer
and choosing Add Existing Item. In the dialog box that appears, you can browse for the files, and
optionally select multiple files by holding down the Ctrl key. Finally, when you click Add, the files
are added to the web site.

However, there is an even easier way to add files to the site, which can be a great time saver when
you need to add multiple existing files and folders to your site: drag and drop. The following Try It
Out shows you how this works.

Adding Existing Files to Your Site

1.

In Windows, minimize all open applications, right-click your desktop, and choose New > Text
Document. If you don’t see this option, simply create a new text document using Notepad and save
it on your desktop.

Rename the text file styles.css. Make sure the . txt extension is replaced by .ess. If you don’t
see the initial .txt extension and the icon of the file doesn’t change from a text file to a CSS file (by
default this is the same icon as a text file but with a gear symbol on top of it, but you may have
software installed that changed the icon for CSS files), Windows is configured to hide extensions
for known file types. If that’s the case, open up Windows Explorer and choose Tools &> Folder
Options in Windows XP or click the Organize button in Windows Vista and Windows 7 and
then choose Folder and Search Options. In both cases, switch to the View tab and deselect the
option labeled Hide Extensions for Known File Types. You now may need to rename the file from
Styles.css.txt to Styles.css.

When you rename the file from .txt to .css, Windows may give you a warning that the file
becomes unusable if you proceed. You can safely answer Yes to this question to continue.

Rearrange VWD so you can see part of the desktop with the CSS file as well. You can use the
Restore Down button next to the Close button on the Windows title bar of VWD to get it out of
full screen mode.
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4. Click the CSS file on the desktop and while holding down the mouse button, drag the file into the
Solution Explorer. Make sure you drag the file into the Solution Explorer and not in other parts
of VWD, or the file won’t be added. For example, when you drag it into the Document Window,

VWD simply opens the file for you, but doesn’t add it to the site.

5.  When you release the mouse while over the web site node or an existing file in the Solution

Explorer (shown in Figure 2-8), the CSS file will be added to your site.
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FIGURE 2-8

Styles.ens

NOTE |If you are using Windows Vista or Windows 7 and run VWD as an admin-
istrator, this might not work because Windows doesn’t allow the Windows
Explorer and VWD to communicate. In that case, add existing files using the Add

Existing Iltem menu discussed earlier or use copy and paste.

How It Works

What’s important to take away from this Try It Out is that VWD creates a copy of the file when it adds
it to the site. So, the original styles.css file on the desktop is not affected when you make changes to
the copy in VWD. This way, it’s easy to drag and drop files out of existing web sites into your new one,
without affecting the originals. The same applies to files you add using the Add Existing Item dialog

box in VWD.




46 | CHAPTER2 BUILDING AN ASP.NET WEB SITE

If you have added files to your web site’s folder outside of VWD, they may not show up right away.
You can get a fresh copy of the file list by clicking the Refresh button on the Solution Explorer’s
toolbar.

Organizing Your Site

Because of the many files that make up your site, it’s often a good idea to group them by function in
separate folders. For example, all Style Sheet files could go in a folder called styles, .7js files could
go in Scripts, user controls could go in a controls folder, and master pages could be stored in a
folder called Masterpages. This is a matter of personal preference, but structured and well-organized
sites are easier to manage and understand. The next Try It Out explains how you can move files
around into new folders to organize your site.

Organizing Your Web Site

1.  Right-click the Planet Wrox site in the Solution Explorer and choose New Folder.

2. Type styles as the new folder name and press Enter.

3. Create another folder, called controls. These two folders will be used in the remainder of this book.

4. Drag the file styles.css that you added earlier and drop it into the styles folder.

5. If everything went well, your Solution Explorer should look like [ T
Figure 2-9. Llguiae |

o CouDegASPHITSEY

If your Solution Explorer looks different from the one shown in K Jriacea
Figure 2-9, follow this Try It Out again until your site looks exactly the , b Dl rrostendmuctes
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How It Works

Structure and organization are important to keep your sites manageable. Although you may be tempted
to add all of your files to the root of your project, it’s better not to do this. With a very small site, you
may not notice any difference, but as soon as your site begins to grow, you’ll find it becomes a lot
harder to manage when it lacks structure. Placing related files in separate folders is the first step to an
organized site. Storing files of the same type in a single folder is only one way to optimize your site. In
later chapters, you see that separate folders are also used to group files with similar functionality. For
example, all files that are accessible only by an administrator of the site are grouped in a folder called
Management.

The drag-and-drop features of VWD make it easy to reorganize your site. Simply pick up one file or
multiple files and drop them in their new location. If you continue to apply these kinds of organiza-
tion practices while expanding your site, you’ll find that tomorrow or six months from now, you
won’t have any problems locating the right file when you need it.
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Special File Types
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a .vb or .cs extension), you get the warning

shown in Figure 2-10.
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When you get this dialog box, always click Yes. Otherwise your file won’t function correctly. You
get similar dialog boxes for other file types, including skin and database files.

Now that you have a good understanding of the different types of files that make up your web site,
it’s time to look at one of them in much more detail: .aspx files, also known as Web Forms.

WORKING WITH WEB FORMS

Web Forms, represented by .aspx files, are the core of any ASP.NET 4 web application. They are
the actual pages that users see in their browser when they visit your site.

As you saw in the previous chapter, Web Forms can contain a mix of HTML, ASP.NET Server
Controls, client-side JavaScript, CSS, and programming logic. To make it easier to see how all this
code ends up in the browser, VWD offers a number of different views on your pages.

The Different Views on Web Forms

VWD enables you to look at your Web Form from a few different angles. When you have a file with
markup — like a Web Form or master page — open in the Document Window, you see three buttons
at the bottom-left corner of the window. With these buttons, visible in Figure 2-11, you can switch
between the different views.
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Source View is the default view when you open a page. It shows you the raw HTML and other
markup for the page, and is very useful if you want to tweak the contents of a page and you have a
good idea of what you want to change where. As I explained in the previous chapter, I use the term
Markup View rather than Source View to refer to the markup of ASPX and HTML pages.

The Design button enables you to switch the Document Window into Design View, which gives

you an idea of how the page will end up. When in Design View, you can use the Visual Aids and
Formatting Marks submenus from the main View menu to control visual markers like line breaks,
borders, and spaces. Both submenus offer a menu item called Show that enables you to turn all the
visual aids on or off at once. Turning both off is useful if you want to have an idea of how the page
ends up in the browser. You should, however, use Design View only to get an idea of how the page
will end up. Although VWD has a great rendering engine that renders the page in Design View
pretty well, you should always check your pages in different browsers as well because what you see
in VWD is the markup for the page before it gets processed. Server Controls on the page may emit
HTML that changes the looks of the page in the browser. Therefore, it’s recommended to view the
page in the browser as often as possible so you can check if it’s going to look the way you want it.
It’s also recommended to test your site in as many different browsers as you can get your hands on
because there may be small differences between them in the way they render a web page. The Planet
Wrox web site has been tested against Microsoft Internet Explorer, Firefox, Google Chrome, Safari,
and Opera. You'll see screenshots of these browsers at various places in the book.

The Split button enables you to look at Design View and Markup View at the same time, as you can
see in Figure 2-12.
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Split View is great if you want to see the code that VWD generates when you add controls to the
Design View of your page. The other way around is very useful too: when you make changes to the
markup of the page in Markup View, you can see how it ends up in Design View. Sometimes Design
View becomes out-of-sync with Markup View. If that’s the case, a message appears at the top of
Design View. Simply clicking the message or saving the entire page is enough to update the Design
window.

If you want your pages to open in a different view than Markup View, choose Tools = Options.
Then expand HTML Designer, and then in the General category, set your preferred view.
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In addition to the HTML and other markup you see in the Markup View window, a Web Form can
also contain code in either C# or Visual Basic .NET. Where this code is placed depends on the type
of Web Form you create. The next section explains the two options you have in more detail.

Choosing between Code Behind and Pages with Inline Code

Web Forms come in two flavors: either as an .aspx file with a Code Bebhind file (a file named after
the Web Form with an additional .vb or .cs extension) or as .aspx files that have their code
embedded, often referred to as Web Forms with inline code. Although you won’t see much code
until Chapter 5, it’s important to understand the difference between these types of Web Forms. At
first, Web Forms with inline code seem a little easier to understand. Because the code needed to
program your web site is part of the very same Web Form, you can clearly see how the code relates
to the file. However, as your page gets larger and you add more functionality to it, it’s often easier
if you have the code in a separate file. That way, it’s completely separate from the markup, enabling
you to focus on the task at hand.

In the next exercise, you add two files that demonstrate the difference between Code Behind and
inline code.

Adding Web Forms with Code to Your Site

The files you add in this exercise aren’t needed for the final application. To avoid cluttering up the proj-
ect, you should put them in a separate Demos folder.

1.  In the Solution Explorer, right-click your web site and choose New Folder. Name the folder Demos
and press Enter.

2. Right-click the Demos folder and choose Add New Item. In the dialog box that appears, choose
your preferred programming language on the left, click the Web Form template and name the
file codeBehind.aspx. Make sure that the check box for Place Code in Separate File is selected.
Finally, click the Add button. The page should open in Markup View so you can see the HTML for
the page.

3. At the bottom of the Document Window, click the Design button to switch the page from Markup
View into Design View. The page you see has a white background with a small, dashed rectangle at
the top of it. The dashed rectangle represents the <div> element you saw in Markup View.

4. From the Toolbox, drag a Label control from the Standard category and drop it in the dashed area
of the page. Remember, you can open the Toolbox with the shortcut Ctrl+Ale+X if it isn’t open yet.
In Design View, your screen should now look like Figure 2-13.
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Double-click somewhere in the white area below the dashed line of the <div> element. VWD
switches from Design View into the Code Behind of the file and adds code that fires when the page
loads in the browser:

VB.NET

Protected Sub Page_Load(ByVal sender As Object, ByVal e As System.EventArgs) _
Handles Me.Load

End Sub

C#

protected void Page_Load(object sender, EventArgs e)

{

Although this odd syntax may look a little scary at this point, don’t worry about it too much
now. In most cases, VWD adds it for you automatically, as you just saw. In later chapters, you see
exactly how this code works, but for now it’s important to realize that the code you’re going to
place between the lines that start with Protected sub and End Sub in Visual Basic and between
the curly braces in C# will be run when the page is requested in the browser. If you are using
Visual Basic, you won’t have the underscore that is visible in this code snippet. I added that here
to split the code over two lines. You see why in the How It Works section after this exercise.

All code examples you’ll see from now on include a Visual Basic (VB.NET) and a C# version so
always pick the one that matches your programming language.

Place your cursor in the open line in the code that VWD created and add the bolded line of code
that assigns today’s date and time to the label, which will eventually show up in the browser:

VB.NET

Protected Sub Page_Load(ByVal sender As Object, ByVal e As System.EventArgs)
Handles Me.Load
Labell.Text = "Hello World; the time is now " & DateTime.Now.ToString()
End Sub

C#

protected void Page_Load(object sender, EventArgs e)
{
Labell.Text = "Hello World; the time is now " + DateTime.Now.ToString();

Note that as soon as you type the L for Label1, you get a list with options to choose from. This

is part of VWD’s IntelliSense, a great tool that helps you rapidly write code. Instead of typing the
whole word Label1, you simply type the letter L or the letters La and then you pick the appropriate
item from the list, visible in Figure 2-14.
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To complete the selected word, you can press Enter or Tab or even the period. In the latter case, you
immediately get another list that enables you to pick the word Text simply by typing the first few
letters, completing the word by pressing the Tab or Enter key. This feature is a real productivity tool
because you can write code with a minimum of keystrokes. IntelliSense is available in many other
file types as well, including ASPX, HTML, CSS, JavaScript, and XML. In many cases, the list with
options pops up automatically if you begin typing. If it doesn’t, press Ctrl+Spacebar to invoke it. If
the list covers some of your code in the code window, press and hold the Ctrl key to make the win-
dow transparent.

Right-click the page in the Solution Explorer and choose View in Browser. Click Yes if you get a
dialog box that asks if you want to save the changes, and then the page will appear in the browser,
similar to the browser window you see in Figure 2-15.
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If you don’t see the message with the date and time appear or you get an error on the page in

the browser, make sure you saved the changes to all open pages. To save all pages at once, press
Ctrl+Shift+S or click the Save All button on the toolbar (the one with the multiple floppy disk
symbols). Additionally, make sure you typed the code for the right language. When you created
this new page, you chose a programming language that applies to the entire page. You can’t mix
languages on a single page, so if you started with a Visual C# page, make sure you entered the C#
code snippet from the Try It Out.

Setting up a page with inline code is very similar. Start by adding a new Web Form to the Demos
folder. Call it Inline.aspx and make sure you uncheck the Place Code in Separate File option.
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9. Just as you did in steps 3, 4, and 5, switch the page into Design View, drag a label inside the <div>
element, and double-click the page somewhere outside the <div> that now contains the label.
Instead of opening a Code Behind file, VWD now switches your page into Markup View, and adds
the Page_T.oad code directly in the page.

10. On the empty line in the code block that VWD inserted, type the bolded line you see in step 6 of
this exercise. Make sure you use the correct programming language. You should end up with the
following code at the top of your .aspx file:

VB.NET

<script runat="server">
Protected Sub Page_Load(ByVal sender As Object, ByVal e As System.EventArgs)
Labell.Text = "Hello World; the time is now " & DateTime.Now.ToString()
End Sub
</script>

C#

<script runat="server">
protected void Page_Load(object sender, EventArgs e)
{
Labell.Text = "Hello World; the time is now " + DateTime.Now.ToString();
}
</script>

11. Right-click the page in the Solution Explorer and choose View in Browser. Alternatively, press
Ctrl+F5 to open the page in your browser. You should see a page similar to the one you got in step 7.

How It Works

At runtime, pages with inline code behave the same as pages that use Code Behind. In both cases, the
ASP.NET runtime sees the Page_Toad code and executes any code it finds in it. In the Try It Out, this
meant setting the Text of Labell to a welcome message and today’s date and time.

Note that in this example, the C# code looks very similar to the VB.NET code. The code that sets the
Label’s text is almost identical in the two languages. One difference is that VB.NET uses an amper-
sand (&) to glue two pieces of text together, but C# uses the plus (+) character. You can also use plus
(+) character in VB.NET to concatenate strings together, but with a few caveats as you’ll learn in
Chapter 5. The other difference is that in C# all code lines must be terminated with a semicolon (;) to
indicate the end of a unit of code, but Visual Basic uses the line break. If you want to split a long line
of code over multiple lines in Visual Basic, you need to use the underscore (_) character. In earlier ver-
sions, VB.NET required the underscore in a lot of different places. However, in Visual Basic 10, the
version that ships with Visual Web Developer 2010, the designers of the language have greatly reduced
the number of places where you need the underscore.

One place where you do need the underscore if you want to split code over multiple lines is right before
the Handles keyword, as you saw in this code snippet from step 6 of the exercise:

Protected Sub Page_Load(ByVal sender As Object, ByVal e As System.EventArgs) _
Handles Me.Load
Labell.Text = "Hello World; the time is now " & DateTime.Now.ToString()
End Sub
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Note that in your page, you won’t see the underscore at the end of the first line of the Visual Basic
example. It was added here because the book’s pages are not wide enough to show the entire code state-
ment on a single line. You’ll see more of these underscores in other Visual Basic examples in the remain-
der of this book. If you decide to manually type the underscore to make your own code more readable,
don’t forget to type an additional space before the actual underscore or your code won’t work.

In C#, you don’t need this character because the language itself allows you to break long lines simply by
pressing Enter. This is because C# uses a semicolon to denote the end of a line instead of a line break in
the source.

You opened the page in your browser using the right-click View in Browser option or by pressing
Ctrl+F5. With the View in Browser option, you always open the page you right-click. With the Ctrl+F5
shortcut, you open the page that is currently the active document in the Document Window, the page
that is currently selected in the Solution Explorer, or the file that has been set as the start page for the
web site. Additionally, all open files are saved automatically, and the site is checked for errors before the
requested page is opened in the browser.

You can assign a page as the start page by right-clicking it in the Solution Explorer and choosing Set As
Start Page. If you want to control this behavior at a later stage, right-click the web site in the Solution
Explorer and choose Property Pages. In the Start Options category, you can indicate that you want the
currently active page to open, or you can assign a specific page, as show in Figure 2-16.
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In the previous exercise, you learned how to add a page that contains a simple Label control.
Additionally, you saw how to write some code that updates the label with today’s date and time.
You can ignore this code for now; it only served to demonstrate the differences between Code
Behind and inline code. In Chapter 5, you learn more about programming in Visual Basic and C#.
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To make compelling pages, you obviously need a lot more content than just a simple Label control
that shows today’s date and time. The next section shows you how to add content and HTML to
your pages and how to style and format it.

Adding Markup to Your Page

You have a number of ways to add HTML and other markup to your pages. First of all, you can
simply type it in the Markup View window. However, this isn’t always the best option, because it
forces you to type a lot of code by hand. To make it easier to insert new HTML in the page and to
apply formatting to it, the Design View window offers a number of helpful tools. These tools include
the Formatting toolbar and the menu items Format and Table. For these tools to be active, you need
to have the document in Design View. If you’re working in Split View mode, you have to make sure
that the Design View part has the focus, or you’ll find that most of the tools are not available.

Inserting and Formatting Text

You can type text in both Design View and in Markup View. Simply place the cursor at the desired
location and start typing. When you switch to Design View, the Formatting toolbar becomes avail-
able, with the options shown in Figure 2-17.
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The drop-down list labeled Block Format enables you to insert HTML elements like <p> for para-
graphs, <n1> through <hé> for headings, and <ul>, <o1>, and <1i> for lists. You can choose an item
from the drop-down list directly to have it inserted in your page, or you